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Instructor Usage of Lab Manual 
 
 This manual is written to help the instructors as much as to help the students.  

The set-up of the manual itself is to assist you get a laboratory experiment or classroom 

demonstration set-up and run.  We also try to help with the student learning but we can’t 

guarantee it everytime.  This lab manual has the following layout: 

• Detailed material on radiation, the Geiger-Müller counter’s operation, and radiation 

interaction with matter.  This way more advanced students can do more background 

reading. 

• Thirteen laboratory experiments ready to be handed out to the students. 

• The same thirteen laboratory experiment write-ups with more notes and sample data 

for the instructors. 

• Sample lesson plan for use of demonstrations in a high school or college-level 

environment. 

 

The equipment from Spectrum Techniques are not necessarily for the laboratory 

environment.  Accomodations and recommendations are made in the teachers’ notes of 

the experimental write-ups for schools that more or less equipment.  We also realize 

that schools operate on different class schedules, varying from 42 minute periods to 3 

hour lab sessions.  Thus, the labs are written with flexibility to combine them in different 

manners (our suggestions are listed below).   

There is a section in the appendix that gives explicit details about how a signal is 

formed for read-out in a Geiger-Müller tube.  There is also a more explicit one that 

teachers may wish to read, or you may give to your advanced students.  This also goes 

for the explanation of what radiation is and the biological dangers.  Lastly, there is a 

section about how radiation interacts with matter.  Again, there is information in a 

teacher’s section that will most likely extend beyond the scope of your course.  In 

addition, there are appendices with information in the SI units, common radioactive 

sources (helpful in planning lab sessions), and detailed explanations of some topics in 

statistics and probability relevant to this material.  
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What is Radiation? 
 

 This section will give you some of the basic information from a quick guide of the 

history of radiation to some basic information to ease your mind about working with 

radioactive sources.  More information is contained in the introduction parts of the 

laboratory experiments in this manual.   

 

Historical Background 

Radiation was discovered in the late 1800s.  Wilhelm Roetgen observed 

undeveloped photographic plates became exposed while he worked with high voltage 

arcs in gas tubes, similar to a fluorescent light.  Unable to identify the energy, he called 

them “X” rays.  The following year, 1896, Henri Becquerel observed that while working 

with uranium salts and photographic plates, the uranium seemed to emit a penetrating 

radiation similar to Roetgen’s X-rays.  Madam Curie called this phenomenom 

“radioactivity”.  Further investigations by her and others showed that this property of 

emitting radiation is specific to a given element or isotope of an element.  It was also 

found that atoms producing these radiations are unstable and emit radiation at 

characteristic rates to form new atoms.   

 Atoms are the smallest unit of matter that retain the properties of an element 

(such as hydrogen, carbon, or lead).  The central core of the atom, called the nucleus, is 

made up of protons (positive charge) and neutrons (no charge).  The third part of the 

atom is the electron (negative charge) which orbits the nucleus.  In general, each atom 

has an equal amount of protons and electrons so that the atom is electrically neutral.  

The atom is made of mostly empty space.  The atom’s size is on the order of an 

angstrom (1 Å), which is equivalent to 1x10 -10 m while the nucleus has a diameter of a 

few fermis, or femtometers, which is equivalent to 1x10-15 m.  This means that the 

nucleus only occupies approximately 1/10,000 of the atom’s size.  Yet, the nucleus 

controls the atom’s behavior with respect to radiation.  (The electrons control the 

chemical behavior of the atom.)   
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Radioactivity 
 

 Radioactivity is a property of certain atoms to spontaneously emit particle or 

electromagnetic wave energy.  The nuclei of some atoms are unstable, and eventually 

adjust to a more stable form by emission of radiation.  These unstable atoms are called 

radioactive atoms or isotopes.  Radiation is energy emitted from radioactive atoms, 

either as electromagnetic (EM) waves or as particles.  When radioactive (or unstable) 

atoms adjust, it is called radioactive decay or disintegration.  A material containing a 

large number of radioactive atoms is called either a radioactive material or a radioactive 

source.  Radioactivity, or the activity of a radioactive source, is measured in units 

equivalent to the number of disintegrations per second (dps) or disintegrations per 

minute (dpm).  One unit of measure commonly used to denote the activity of a 

radioactive source is the Curie (Ci) where one Curie equals thirty seven billion 

disintegrations per second. 

1 Ci = 3.7x1010 dps = 2.2x1012 dpm 

The SI unit for activity is called the Becquerel (Bq) and one Becquerel is equal to one 

disintegration per second. 

1 Bq = 1 dps = 60 dpm 

 

Origins of Radiation 
 

Radioactive materials that we find as naturally occurring were created by: 

1. Formation of the universe, producing some very long lived radioactive elements, 

such as uranium and thorium. 

2. The decay of some of these long lived materials into other radioactive materials like 

radium and radon. 

3. Fission products and their progeny (decay products), such as xenon, krypton, and 

iodine.   

 

Man-made radioactive materials are most commonly made as fission products or 

from the decays of previously radioactive materials.  Another method to manufacture 
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radioactive materials is activation of non-radioactive materials when they are 

bombarded with neutrons, protons, other high energy particles, or high energy 

electromagnetic waves. 

 

Exposure to Radiation 
 

 Everyone on the face of the Earth receives background radiation from natural 

and man-made sources.  The major natural sources include radon gas, cosmic 

radiation, terrestrial sources, and internal sources.  The major man-made sources are 

medical/dental sources, consumer products, and other (nuclear bomb and disaster 

sources).   

 Radon gas is produced from the decay of uranium in the soil.  The gas migrates 

up through the soil, attaches to dust particles, and is breathed into our lungs.  The 

average yearly dose in the United States is about 200 mrem/yr.  Cosmic rays are 

received from outer space and our sun.  The amount of radiation depends on where you 

live, lower elevations receive less (~25 mrem/yr) while higher elevations receive more 

(~50 mrem/yr).  The average yearly dose in the United States is about 28 mrem/yr.  

Terrestrial sources are sources that have been present from the formation of the Earth, 

like radium, uranium, and thorium.  These sources are in the ground, rock, and building 

materials all around us.  The average yearly dose in the United States is about 28 

mrem/yr.  The last naturally occurring background radiation source is due to the various 

chemicals in our own bodies.  Potassium (40K) is the major contributor and the average 

yearly dose in the United States is about 40 mrem/yr. 

 Background radiation can also be received from man-made sources.  The most 

common is the radiation from medical and dental x-rays.  There is also radiation used to 

treat cancer patients.  The average yearly dose in the United States is about 54 

mrem/yr.  There are small amounts of radiation in consumer products, such as smoke 

detectors, some luminous dial watches, and ceramic dishes (with an orange glaze). The 

average yearly dose in the United States is about 10 mrem/yr.  The other man-made 

sources are fallout from nuclear bomb testing and usage, and from accidents such as 

Chernobyl. The average yearly dose in the United States is about 3 mrem/yr. 
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 Adding up the naturally occurring and man-made sources, we receive on 

average about 360 mrem/yr of radioactivity exposure.  What significance does this 

number have since millirems have not been discussed yet?  Without overloading you 

with too much information, the government allows you 5,000 mrem/yr.  (This is the 

Department of Energy’s Annual Limit.)  This is three times below the level of exposure 

for biological damage to occur. So just by living another year (celebrating your birthday), 

you receive about 7% of the government regulated radiation exposure.  If you have any 

more questions, please ask your teacher. 
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The Geiger-Müller Counter 
 
 Geiger-Müller (GM) counters were invented by H. Geiger and E.W. Müller in 

1928, and are used to detect radioactive particles (α and β) and rays (γ and x).  A GM 

tube usually consists of an airtight metal cylinder closed at both ends and filled with a 

gas that is easily ionized (usually neon, argon, and halogen).  One end consists of a 

“window” which is a thin material, mica, allowing the entrance of alpha particles.  (These 

particles can be shielded easily.)  A wire, which runs lengthwise down the center of the 

tube, is positively charged with a relatively high voltage and acts as an anode.  The tube 

acts as the cathode.  The anode and cathode are connected to an electric circuit that 

maintains the high voltage between them.   

 When the radiation enters the GM tube, it will ionize some of the atoms of the 

gas*.  Due to the large electric field created between the anode and cathode, the 

resulting positive ions and negative electrons accelerate toward the cathode and anode, 

respectively.  Electrons move or drift through the gas at a speed of about 104 m/s, which 

is about 104 times faster than the positive ions move.   The electrons are collected a few 

microseconds after they are created, while the positive ions would take a few 

milliseconds to travel to the cathode.  As the electrons travel toward the anode they 

ionize other atoms, which produces a cascade of electrons called gas multiplication or a 

(Townsend) avalanche.  The multiplication factor is typically 106 to 108.  The resulting 

discharge current causes the voltage between the anode and cathode to drop.  The 

counter (electric circuit) detects this voltage drop and recognizes it as a signal of a 

particle’s presence.  There are additional discharges triggered by UV photons liberated 

in the ionization process that start avalanches away from the original ionization site.  

These discharges are called Geiger-Müller discharges.  These do not effect the 

performance as they are short-lived. 

 Now, once you start an avalanche of electrons how do you stop or quench it?  

The positive ions may still have enough energy to start a new cascade.  One (early) 

method was external quenching which was done electronically by quickly ramping down 

the voltage in the GM tube after a particle was detected.  This means any more 
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electrons or positive ions created will not be accelerated towards the anode or cathode, 

respectively.  The electrons and ions would recombine and no more signals would be 

produced.   

The modern method is called internal quenching.  A small concentration of a 

polyatomic gas (organic or halogen) is added to the gas in the GM tube.  The quenching 

gas is selected to have a lower ionization potential (~10 eV) than the fill gas (26.4 eV).  

When the positive ions collide with the quenching gas’s molecules, they are slowed or 

absorbed by giving its energy to the quenching molecule.  They break down the gas 

molecules in the process (dissociation) instead of ionizing the molecule.  Any quenching 

molecule that may be accelerated to the cathode dissociates upon impact producing no 

signal.  If organic molecules are used, GM tubes must be replaced as they loss they 

permanently break down over time (about one billion counts).  However, the GM tubes 

included in Spectrum Techniques® set-ups use a halogen molecule, which naturally 

recombines after breaking apart.  

For any more specific details, we will refer the reader to literature such as G.F. 

Knoll’s Radiation Detection and Measurement (John Wiley & Sons) or to Appendix E of 

this lab manual.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                                                                                                                                                                    
* A γ-ray interacts with the wall of the GM tube (by Compton scattering or photoelectric effect) to produce an 
electron that passes to the interior of the tube.  This electron ionizes the gas in the GM tube. 
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Physics Lab 

Good Graphing Techniques 
 
Very often, the data you take in the physics lab will require graphing.  The following are a few general 
instructions that you will find useful if you wish to receive maximum credit. 
 
1. Each graph MUST have a TITLE. 

 
2. Make the graph fairly large – use a full sheet of graph paper for each graph.  By 

using this method, your accuracy will be better, but never more accurate that the 

data originally taken. 

 
3. Draw the coordinate axes using a STRAIGHT EDGE.  Each coordinate is to be 

labeled including units of the measurement. 

 
4. The NUMERICAL VALUE on each coordinate MUST INCREASE in the direction 

away from the origin. 

 

Choose a value scale for each coordinate that is easy to work with.  The range of the 

values should be appropriate for the range of your data. 

 

It is NOT necessary to write the numerical value at each division on the coordinate.  

It is sufficient to number only a few of the divisions.  DO NOT CLUTTER THE 

GRAPH. 

 
5. Circle each data point that you plot to indicate the uncertainty in the data 

measurement. 

 
6. CONNECT THE DATA POINTS WITH A BEST-FIT SMOOTH CURVE unless an 

abrupt change in the slope is JUSTIFIABLY indicated by the data. 
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DO NOT PLAY CONNECT-THE-DOTS with your data!  All data has some 

uncertainty.  Do NOT over-emphasize that uncertainty by connecting each point. 

 
7. Determine the slope of your curve: 

(a) Draw a slope triangle – use a dashed line. 

(b) Your slope triangle should NOT intersect any data points, just the best-fit curve. 

(c) Show your slope calculations right on the graph, e.g.,  

answer
xx

yy

x

y
slope =

−
−

=
∆
∆

=
12

12  

BE CERTAIN TO INCLUDE THE UNITS IN YOUR SLOPE CALCULATIONS. 

 
8. You may use pencil to draw the graph if you wish. 

 
9. Remember: NEATNESS COUNTS. 
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Lesson Plan – Introduction to Radiation 
(This format is similar to the one used by the author and is written for  

    use with a high school class.  Feel free to adjust for your class’s level 
     as necessary.) 

 
Objectives: 
1. The learner will state the three forms of radiation from nuclear decay. 
2. The learner will identify the type of radiation given information on the range. 
3. The learner will list at least three basic facts on radiation safety. 
 
Set:  
 Ask, “Can anyone tell me what radiation is?”  “Where have you seen it used 
before?”   
 
Instructional Strategies: 
 Inquiry, Socratic Method, and Direct Instruction. 
 
Lesson: 
1. Discuss how radiation is produced (nuclear decay) due to nuclear instability 
2. Ask: Is all radiation the same?  Is it all harmful?  Is radiation in this room right now?  

Yesterday?   
3. Demonstration: Use the ST350, ST250, or ST150 to demonstrate that there are 

different forms of radiation.  (Details below) 
4. Introduce the forms of radiation:  

• Alpha (α) particle – a helium nucleus 
• Beta (β) particle – an electron 
• Gamma (γ) ray – a highly energetic photon 

5. Discuss with students if the different radiation forms must have different properties 
(steer students toward properties). 

6. Discuss safety facts for radiation with students (Details below) 
 
Closure: 
 Ask students to think about all the times they have been exposed to radiation.  
(X-rays, sunlight, etc.)  Ask them if they have felt any ill effects? 
 Perform a background count for your Geiger counter to show there is radiation all 
around us. 
 
Demonstration: 
 Do not allow the student to see the sources’ labels.  Place the alpha source on 
the tray and place it on the top shelf.  Take a count for one minute, allowing the 
students to see the accumulation of data (project computer screen onto TV, expand size 
of counting window so all can see, or allow the students to gather around and watch the 
counts).  Have at least one student record the number of counts.  Next, place a piece of 
paper on top of the source.  Count again and record this data. 



13 

 

 Repeat this for a beta source, but place the beta source on the second shelf.  
Take a one minute count with just the source, with a piece of paper on top of it, and now 
a piece of aluminum a few mm thick (at least 300 mg/cm2 in absorber thickness to 
completely block the betas above background).  Record the data each time. 
 For the gamma source, repeat the procedure for the beta source.  You may 
choose to add one more absorber (lead is suggested).  Record all the data. 
 Ask the students if they notice any differences.  Put these differences on the 
overhead or board.  Allow the students to discover that there are three separate types of 
radiation.  Then identify them to the class. 
 
Radiation Safety: 
 Radiation like anything else can be dangerous.  The sources used for this 
experiment are exempt sources, which means that they give off very little radiation 
compared to what the government (NRC – Nuclear Regulatory Council) deems 
dangerous sources.  Exempt sources, as long as they are not in quantities of hundreds, 
require no special shielding, storage, or disposal.  We suggest that they be securely 
stored so that students or non-authorized personal do not take them.  (These could be 
storing them out of sight in your desk.)   

We also suggest that common sense be used when handling these sources.  
Basic laboratory safety procedures should be followed.  Treating a source in the same 
manner as a chemical is a good idea.  Not eating and not inhaling the source or any 
part of it will eliminate the two worst ways to have radiation exposure.  Also, no special 
disposal is required.  However, government regulations do require that you deface or 
remove the label before disposing of them in normal trash containers.   

Any further questions about exempt sources can be directed to Spectrum 
Techniques, Inc. (865) 482-9937 or to the NRC regulations which appear on the GPO’s 
(Government Printing Office) website (http://www.access.gpo.gov/nara/cfr) where one 
can find the regulation 10 CFR Part 30.18 and 30.711 on exempt quantity sources. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                             
1 These regulations are included in Appendix G. 
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Lab #1: Plotting a GM Plateau 

Objective: 

 In this experiment, you will determine the plateau and optimal operating voltage 

of a Geiger-Müller counter. 

 

Pre-lab Questions: 

1. What will your graph look like (what does the plateau look like)? 

Answer: An “S” shape.  Up from bottom left, leveling out for a bit, and up at top 

right.  This would the “standard” plateau plot. 

2. Read the introduction section on GM tube operation.  How does electric potential 

effect a GM tube’s operation? 

Answer: The electrical potential controls the electron multiplication, which effects 

the size of the signal.  The size determines whether the pulse is detected or not.  

(The electric potential determines the size of the electric field which actually does 

this.) 

 

Introduction: 

 All Geiger-Müller (GM) counters do not operate in the exact same way because 

of differences in their construction.  Consequently, each GM counter has a different high 

voltage that must be applied to obtain optimal performance from the instrument. 

 If a radioactive sample is positioned beneath a tube and the voltage of the GM 

tube is ramped up (slowly increased by small intervals) from zero, the tube does not 

start counting right away.  The tube must reach the starting voltage where the electron 

“avalanche” can begin to produce a signal.  As the voltage is increased beyond that 

point, the counting rate increases quickly before it stabilizes.  Where the stabilization 

begins is a region commonly referred to as the knee, or threshold value.  Past the knee, 

increases in the voltage only produce small increases in the count rate.  This region is 

the plateau we are seeking.  Determining the optimal operating voltage starts with 

identifying the plateau first.  The end of the plateau is found when increasing the voltage 
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produces a second large rise in count rate.  This last region is called the discharge 

region. 

 To help preserve the life of the tube, the operating voltage should be selected 

near the middle but towards the lower half of the plateau (closer to the knee).  If the GM 

tube operates too closely to the discharge region, and there is a change in the 

performance of the tube.  Then you could possibly operate the tube in a “continuous 

discharge” mode, which can damage the tube. 

Geiger Plataeu
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Figure 1: A plateau graph for a Geiger-Müller counter. 

By the end of this experiment, you will make a graph similar to the one in Figure 1, 

which shows a typical plateau shape. 

 

Equipment 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) as shown in Figure 2. 
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Figure 2: ST350 setup with sources and absorber kit. 

• Radioactive Source (e.g., Cs-137, Sr-90, or Co-60) – One of the orange, blue, 

or green sources shown above in Figure 2. 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 
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Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Go to the Setup menu and select the HV Setting option.  In the High Voltage (HV) 

window, start with 700 Volts.  In the step voltage window, enter 20.  Under Step 

Voltage Enable, select On (the default selection is off).  Finally, select OK. 

4. Go under the Preset option and select Preset Time.  Enter 30 for the number of 

seconds and choose OK.  Then also under the Preset option choose Runs.  In the 

window, enter 26 for the number of runs to make. 

5. You should see a screen with a large window for the number of counts and data for 

all the runs on the left half of the screen.  On the right half, you should see a window 

for the preset time, elapsed time, runs remaining, and HV and step voltages.  If not, 

go to the view option and select counts. 

6. Make sure no other previous data by choosing the erase button (last one on the 

right).  Then select the green diamond to start taking data. 

7. When all the runs are taken, choose the File menu and Save As.  Then you may 

save the data file anywhere on the hard drive or onto a floppy disk.  The output file is 

a text file that is tab delimited, which means that it will load into most spreadsheet 

programs.  See the Data Analysis section for instructions in doing the data analysis 

in Microsoft Excel ®.  Another option is that you may record the data into your own 

data sheet and graph the data on the included graph paper. 

8. You can repeat the data collection again with different values for step voltage and 

duration of time for counting.  However, the GM tubes you are using are not allowed 

to have more than 1200 V applied to them.  Consider this when choosing new 

values. 

Data Analysis 

1. Open Microsoft Excel ®.  From the File Menu, choose Open.  Find the directory 

where you saved your data file.  (The default location is on the C drive in the 

SpecTech directory.)  You will have to change the file types to All Files (*.*) to find 

your data file which ends with .tsv.  Then select your file to open it. 
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2. The Text Import Wizard will appear to step you through opening this file.  You may 

use any of the options available, but you need only to press Next, Next, and Finish 

to open the file with all the data. 

3. To see all the words and eliminate the ### symbols, you should expand the width of 

the A and E columns.  Take the cursor up to where the letters for the columns are 

located.  When the cursor is on the line between two columns, it turns into a line with 

arrows pointing both ways.  Directly over the lines between the A and B columns and 

E and F columns, double-click and the columns should automatically open to the 

maximum width needed. 

4. To make a graph of this data, you may plot it with Excel ® or on a sheet of graph 

paper.  If you choose Excel, the graphing steps are provided. 

5. Go the Insert Menu and choose chart for the Chart Wizard, or select it from the top 

toolbar (it looks like a bar graph with different color bars).   

6. Under Chart Types, select XY (Scatter) and choose Next.  (This default selection for 

a scatter plot is what we want to use.) 

7. For the Data range, you want the settings to be on “=[your file name]!$B$13:$C$32”, 

putting the name you chose for the data file in where [your file name] is located (do 

not insert the square brackets or quotation marks).  Also, you want to change the 

Series In option from Rows to Columns.  To check to see if everything has worked, 

you should have a preview graph with only one set of points on it.  Or you can go to 

the Series Tab and for X Values should be “=[your file name]!$B$13:$B$32” and for 

Y Values should be “=[your file name]!$C$13:$C$32”.  If this is correct, then choose 

Next again. 

8. Next, you are given windows to insert a graph title and labels for the x and y-axes.  

Recall that we are plotting Counts on the y-axis and Voltage on the x-axis.  When 

you have completed that, choose the legend tab and unmark the show legend option 

(remove the check mark by clicking on the box).  A legend is not needed here unless 

you plotting more than one set of runs together. 

9. Next, you are asked to choose whether to keep the graph as a separate worksheet 

or to shrink it and insert it onto your current worksheet.  This choice is up to your 
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instructor or you depending on how you want to choose your data presentation for 

any lab report. 

10. If you insert the chart onto the spreadsheet, adjust its size to print properly.  Or 

adjust the settings in the Print Preview Option (to the right of print on the top 

toolbar).   

 

Conclusions: 

 Now that you have plotted the GM tube’s plateau, what remains is to determine 

an operating voltage.  You should choose a value near the middle of the plateau or 

slightly left of what you determine to be the center.  Again, this will be somewhat difficult 

due to the fact that you cannot see where the discharge region begins. 

Post-Lab Questions: 

1. The best operating voltage for the tube =     Volts. 

2. Will this value be the same for all the different tubes in the lab? 

3. Will this value be the same for this tube ten years from now? 

4. One way to check to see if your operating voltage is on the plateau is to find the 

slope of the plateau with your voltage included.  If the slope for a GM plateau is less 

than 10% per 100 volt, then you have a “good” plateau.  Determine where your 

plateau begins and ends, and confirm it is a good plateau.  The equation for slope is 

 ( ) ( )
100

/100
%

12

112 ×
−
−

=
VV

RRR
slope , 

      where R1 and R2 are the activities for the beginning and end points, respectively.  V1 

         and V2 and the voltages for the beginning and end points, respectively.  (This 

      equation measures the % change of the activities and divides it by 100 V.)   
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  Data Table for Geiger Plateau Lab    

      
Tube #:      
      

Voltage Counts  Voltage Counts 

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

 

 

Name:       Lab Session:     
Date:        Partner:      

Don’t forget to hand in this data sheet with a graph of the data. 



21 

 

Lab #2: Statistics of Counting 

 

Objective: 

 In this experiment, the student will investigate the statistics related to 

measurements with a Geiger counter.  Specifically, the Poisson and Gaussian 

distributions will be compared. 

 

Pre-lab Questions: 

1. List the formulas for finding the means and standard deviations for the 

Poisson and Gaussian distribution. 

Answer:  Poisson:  ∑=
i

ixx   and  x=σ so 
Nx

σ
σ =  

Gaussian: ∑=
i

ixx   and  
( )

1

2

−

−
=

∑
N

xx
i

i

σ and 
Nx

σ
σ =  

2. A student in a previous class of the author’s once made the comment, “Why 

do we have to learn about errors?  You should just buy good and accurate 

equipment.”  How would you answer this student?  

Answer: Check students’ answers, but there should be some discussion 

about how every measurement contains some error.  Obtaining 100% 

accuracy is impossible. 

 

Introduction: 

 Statistics is an important feature especially when exploring nuclear and particle 

physics.  In those fields, we are dealing with very large numbers of atoms 

simultaneously.  We cannot possibly deal with each one individually, so we turn to 

statistics for help.  Its techniques help us obtain predictions on behavior based on what 

most of the particles do and how many follow this pattern.  These two categories fit a 

general description of mean (or average) and standard deviation.   
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A measurement counts the number of successes resulting from a given number 

of trials.  Each trial is assumed to be a binary process in that there are two possible 

outcomes: trial is a success or trial is not a success.  For our work, the probability of a 

decay or non-decay is a constant every moment in time.  Every atom in the source has 

the same probability of decay, which is very small (you can measure it in the Half-life 

experiment).     

The Poisson and Gaussian statistical distributions are the ones that will be used 

in this experiment.  A true introduction to those distributions can be found in Appendix C 

of this manual.   

 

Equipment 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – Shown in Figure 1. 
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Figure 1: Setup for ST350 with sources and absorber kit 

• Radioactive Source (Cs-137 is recommended – the blue source in Figure 1) 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 
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Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Go to the Preset menu and set Preset Time.  Set this value to 5.  Then under the 

Preset menu, set Runs to 150.  You will measure the radiation that is all around us 

right now. 

4. Click on the green diamond to begin taking data.  (This is run for twelve and a half 

minutes.) 

5. When you are done, save your data onto disk (preferred for 150 data points).   

6. Repeat with a Cesium-137 source, but reset the time to 1 second and the number of 

runs to 750 (again will be twelve and a half minutes.) 

 

Data Analysis 

1. Open Microsoft Excel ®.  From the File Menu, choose Open.  Find the directory 

where you saved your data file.  (The default location is on the C drive in the 

SpecTech directory.)  You will have to change the file types to All Files (*.*) to find 

your data file which ends with .tsv.  Then select your file for the 150 counts of 

background to open it. 

2. The Text Import Wizard will appear to step you through opening this file.  You may 

use any of the options available, but you need only to press Next, Next, and Finish 

to open the file with all the data. 

3. First, enter all of the titles for numbers you will calculate.  In cell G10, enter Mean.  In 

cell G13, enter Minimum.  In cell G16, enter Maximum.  In cell G19, enter Standard 

Deviation.  In cell G22, enter Square Root of Mean.  In cell H10, enter N.  In cell I10, 

enter Frequency.  In cell J10, enter Poisson Dist.  Finally, in cell K10, enter 

Gaussian Dist. 

4. In cell G11, enter =AVERAGE(C12:C161). 

5. In cell G14, enter =MIN(C12:C161). 

6. In cell G17, enter =MAX(C12:C161). 

7. In cell G20, enter =STDEV(C12:C161) 

8. In cell G22, enter =SQRT(G11) 
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9. Starting in cell H11, list the minimum number of counts recorded (same as 

Minimum), which could be zero.  Increase the count by one all the way down until 

you reach the maximum number of counts. 

10. In column I, highlight the empty cells that correspond to N values from column H.  

Then from the Insert menu, choose function.  A window will appear, you will want to 

choose the FREQUENCY option that can be found under Statistical (functions listed 

in alphabetical order).  Once you choose Frequency, another window will appear.  In 

the window for Data_Array, enter C12:C161 (cells for the data).  In the window for 

Bin_Array, enter the cells for the N values in column H.  (You can highlight them by 

choosing the box at the end of the window.)  STOP HERE!!  If you hit OK here, the 

function will not work.  You must simultaneously choose, the Control key, the Shift 

key, and OK button (on the screen).  Then the frequency for all of your N values will 

be computed.  If you did not do it correctly, only the first frequency value will be 

displayed. 

11. In cell J11, enter the formula =$G$11^H11/FACT(H11)*EXP(-$G$11)*150 for the 

Poisson Distribution.  (You must multiply the standard formula by 150, because the 

standard formula is normalized to 1.) 

12. In cell K11, enter the formula =(1/($G$20*SQRT(2*PI())))*EXP(-((H11-

$G$11)^2)/(2*$G$20^2))*150 for the Gaussian Distribution.  Note that in Excel  the 

number p is represented by PI().  Again, you must multiply by 150 to let the function 

know how many entries there are. 

13. Next, make a graph of all three distributions: Raw Frequency, Poisson Distribution, 

and Gaussian Distribution.  Start with the Chart Wizard either by choosing Chart 

from the Insert Menu or pressing its icon on the top toolbar. 

14. Select the XY (Scatter) Plot from Plot Types and click on Next. 

15. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  However, for this lab, there is one way that is 

much easier than the other.  Choose the Series tab at the top of the page.  Click 

Remove to eliminate all of the series listed as default values.  Now choose Add.  In 

the Name window, type Raw Frequency.  Now using the cursor button to the right of 

the X-Values window, highlight the N values in the H column.  Hit enter or return to 
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return to the Chart Wizard window.  Using the cursor button to the right of the Y-

Values window, highlight the Frequency values in the I column.  Now add two more 

series, one for the Poisson Distribution and one for the Gaussian Distribution.  When 

done, lick on Next. 

16. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names (Counts for the x-axis and Frequency for the y-axis) and units (if applicable) 

for those items.  When you are done, click Next 

17. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

18. Adjust the size of the graph for your preference (or the instructor’s).  You may also 

wish to adjust the scales on one or more of the axes.  This is a preference issue. 

19. Print the graph to hand in to your instructor. 

20. Repeat this whole data analysis procedure for your counts with Cs-137. 

  

Conclusions: 

 What you have plotted is the frequency plot for your data.  In addition, you have 

plotted on top of them the predictions of a Poisson and Gaussian Distribution.   (Note: 

for the Cs-137 data, the Poisson distribution will read #NUM, because the number is too 

high for Excel to deal with, even in scientific notation.)  How well do the statistical 

distributions predict the data?  How close are the standard deviations?   One better than 

the other?  Do the normal conditions of when to use the Gaussian and Poisson 

distributions apply correctly? 

 

 

Post-Lab Questions: 

1. Which distribution matches the data with the background counts?  How well does 

the Gaussian distribution describe the Cs-137 data? 

Answer: Poisson should better predict the background counts while Gaussian 

should predict the Cs-137 counts very well. 
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2. Why can’t you get a value for the Poisson distribution with the data from the Cesium-

137 source? 

Answer:  The mean is too large.  It makes the Poisson distribution value way too 

large for Excel to handle. 

3. How close are the standard deviation values when calculated with the Poisson and 

Gaussian distributions?  Is one right (or more correct)?  Is one easier to calculate? 

Answer: The standard deviation values tend to be fairly close.  They are closer 

for the background counts than for the Cs-137 counts.  One is more correct if 

more correctly predicts the data, so in reality only one is slightly better than the 

other.  The Poisson is much easier to calculate by hand, it is the square root of 

the mean. 
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   Data Sheet for Statistics Lab 
      
Tube #:    Tube #:  

Source:    Source:  

Run Duration:    Run Duration:  

(Time)    (Time)  
      

Run # Counts   Run # Counts 
      

      

      

      

      

      

      

      

      

      

      

      

Data Set Mean Gaussian σσ  Poisson σσ    

Background      

Cs-137      

      

 

Name:       Lab Session:     
Date:        Partner:      

Don’t forget to hand in this data sheet with a graph of the data. 
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Lab #3: Background 

Objective:  

 The student will investigate background radiation, learn how to measure it, and 

compensate for it. 

Pre-lab Questions: 

1. Name the four natural sources and three man-made sources of background 

radiation. 

Answer: (1) Cosmic Rays, (2) Terrestial Sources (uranium in rock), (3) 

Radon Gas (from decayed uranium in rock), and (3) Internal Sources (40K 

in our bodies) 

2. Approximately how much background radiation is received by an average 

American citizen every year?  Is this very much? 

Answer: 360 mrem/yr ≈ 1 mrem/day.  This is 7.2% of the allowed dosage 

for radiation workers and 0.72% of the dosage necessary to cause 

biological damage.  So this not very much, but it is still present. 

 

Introduction: 

 In an introductory section of this manual called, What is Radiation, there is a 

section that deals with the radiation that is around us everyday of our lives.  Normally 

we don’t even think about it.  However, every living organism contains a radioactive 

isotope of carbon, Carbon-14.  Whenever you watch TV or look at any object, you must 

receive the light waves, which are electromagnetic radiation.  Cell phones also transmit 

via are electromagnetic radiation.  It is all around us and we can’t escape from it.  But 

we are lucky, because the power and dosage is so small there are no immediate 

biological effects.   

 The GM tube is just like a human, it is being bombarded by radiation constantly.  

That extra radiation shows up in our GM tube as a count, but it is impossible to 

determine the origin of the count as from the radioactive source being investigated or 

background.  This causes an erroneous sample count, especially when the counts are 

low.  The error can be very high.  Therefore, the background count must be determined 
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and the sample’s counts must be corrected for it.  It is not a difficult process and is 

rather straight forward.  You find the number of counts from a source and without a 

source.  You subtract the counts obtained without the source from those obtained with a 

source, and that should give you the number of counts from the source itself. 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 

Figure 1: Setup for ST350 with sources and absorber kit. 

• Radioactive Source (e.g., Cs-137, Sr-90, or Co-60 – one of the blue, green, or 

orange sources shown in figure 1) 
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Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

21. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

22. Under the Preset Menu, choose Runs.  Set the number of runs at 3.  Also under the 

Preset Menu, choose Preset Time.  Set the time for 5 minutes (or 300 seconds). 

23. Click on the green diamond to begin taking data.  

24. After the third run has finished, record your data by saving to the hard drive, a floppy 

disk, or using a data table.   

25. Insert a radioactive source into one of the (upper) shelves.   Complete another 3 

runs of 5 minutes each with the radioactive source. 

26. Record your data on some scrap paper or a data table, because you will combine it 

with the rest of the data later. 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. Beginning in cell A4, fill in the appropriate data for the three runs you performed with 

the radioactive source inserted.  You do not have to fill in the Time/Date information, 
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but the run number, high voltage, counts, and elapsed time should all be filled with 

data. 

3. Go to cell A19, insert the title Average Counts.  In cell A20, put the title Average 

Background.  In cell A21, put the title Average True Counts. 

4. In cell B19, enter the equation =(SUM(C15:C17))/3 to calculate the average of the 

counts with the source present.  In cell B20, enter the equation =(SUM(C12:C14))/3 

to calculate the average number of background counts.  In cell B21, enter the 

equation =B19-B20 to calculate the number of counts from the source accounting for 

background radiation. 

 

Conclusions: 

 As you should see from your data, the background radiation is not high 

compared to a radioactive source.  You should now know how to deal with background 

radiation to obtain a more accurate reading of counts from a radioactive source. 

 

Post-Lab Questions: 

1. Is there anyway to eliminate background radiation? 

Answer:  Complete shielding of lead and concrete, but it is not practical. 

2. What is your prediction for the number of background radiation counts that 

your body would receive?  (Hint: find the value for counts per minute, cpm, 

and multiple by the number of minutes in one day.)  How many counts per 

year? 

Answer:  The exact number depends on the student’s data.  But let’s 

assume that the student got 40 cpm.   Then, the student would get 40 x 

1440 = 57,600 counts per day, and 57,600 x 365 = 21, 024, 000 counts 

per year of radiation.   

3. Are all the background measurements exactly the same number of counts?  

Is there a systematic cause for this? 

Answer:  No, values may repeat but they are not all the same.  This is a 

probabilistic or random process. 
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  Data Sheet for Background Lab 
      
Tube #:    Tube #:  

Run Duration:    Run Duration:  

(Time)   (Time)  
     

Run # Counts  Run # Counts 
     

     

     

     

     

     

     

 Background Count    

     

Run # Corrected Counts  Run # Corrected Counts 
     

     

     

     

     

 

 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in this data sheet with any lab report. 
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Lab #4: Resolving Time 
 

Objective:  

 The student will determine the resolving time of a GM counter. 

 

Pre-lab Questions: 

1. When radiation travels through the window of the GM tube, what happens so that 

the tube sends a signal that it has detected a particle? 

Answer: The radiation through one process (or another) ionizes the gas, the 

electron multiplies on its way to the anode, the avalanche reaches the anode and 

creates a voltage pulse. 

2. Can the GM counter distinguish between one or more particles when they are 

present in the tube at the same time? 

Answer: No, the electron avalanches would overlap and send virtually one signal 

that the Geiger counter sees.  This is because the Geiger counter works only on 

a “yes” and “no” signal for radiation passing through it. 

 

Introduction: 

 When a particle decays and produces radiation, those particles or rays can 

produce an ion pair through ionization in the Geiger tube1.  The electrons travel to the 

anode more quickly than the positive ions travel to the cathode.  During the time it takes 

the positive ions to reach the cathode, the tube is insensitive to any radiation.  During 

this time, if a second ionizing ray strikes the tube it will not be detected because the 

tube cannot tell there is another electron avalanche present.  The Geiger counter only 

sees one “big” electron avalanche, until it has been reset after detection.  Basically, the 

counter cannot produce pulses for more than one particle, because the counter is 

“occupied” with the particle that arrives earliest.  This phenomenon is sometimes called 

coincidence. 

                                                             
1 Make sure you read the appendix on the operation of a Geiger-Müller counter.  Some aspects on how the Geiger 
counter works are assumed knowledge for the student. 
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 As a result of coincidence, the observed counts are always lower than the true 

counts.  An approximate correction for coincidence is made by adding approximately 

0.01% per 100 cpm (counts per minute) to the observed count rate, if it is assumed that 

the resolving time2 is about 5 µs.  True resolving times span a range from a few 

microseconds for small tubes to 1000 microseconds for very large detectors.  The loss 

of particles is important, especially when there are high count rates involved and the 

losses accumulate into large numbers. 

 In this experiment, you will perform a more accurate analysis of dead time via a 

method that uses paired sources.  The count rates, or activities, of two sources are 

measured individually (r1 and r2) and then together (r3).  The paired samples form a disc 

cut into two lengthwise.  A small quantity of radioactive material is placed on each half 

making each a “half-source” of approximately equal strength.  A blank disk is used to 

duplicate the set-up geometry while using only one half-source.  (NOTE: You must keep 

the experimental set-up the same or there is a chance that results may change.  This is 

a common experimental requirement for all sciences.) 

 

Theory: 

 If we anticipate a counting rate, R, from a radioactive source, then the presence 

of coincidence will mean that the rate we actually measure, r, will be less than the 

expected value (r < R).  If this GM tube has a dead time of T, then the equation for the 

true count rate is 

R = r + rRT.                      (1) 

 This allows use to find an equation to correct our counting rate for dead time 

     
rT

r
R

−
=

1
.                      (2)  

You will have r from your data, and you asked to find R.  What about T?  We look at our 

two-source method of data taking.  We measure the activity from two half-sources, r1 

and r2.  Then, we measure their combined activity, r3, so we can use this set-up to our 

advantage.  We expect that the  

                                                             
2 Resolving Time is more commonly referred to as Dead Time by scientists, because in essence the detector is 
“dead” and cannot detect any other radiation in this time window. 
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     r1 + r2 = r3 + b                       (3) 

where b is the background counting rate.  If these counting rates are corrected for dead 

time, Equation (3) becomes 

    
Tr

r

1

1

1−
 + 

Tr

r

2

2

1−
 = 

Tr

r

3

3

1−
 + b                     (4) 

We do not correct b, because any correction would only be a fraction of a count.  Since, 

the count rate is negligible, Equation (4) can be changed into the form of a quadratic 

equation 

    r1r2r3T
2 – 2r1r2T + r1 + r2 – r3 = 0.                    (5) 

T is on the order of microseconds, so T2 will also be negligible.  This allows a very 

simple algebraic equation to be solved for T: 

     
21

321

2 rr

rrr
T

−+
= .                  (6) 

Now, we can solve for R in Equation (2). 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 
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Figure 1: Setup for ST350 with sources and absorber kit. 

• Radioactive Half-Source Kit (3 Half Discs – One Blank and Two of Tl-204) – 

shown in Figure 2 

Figure 2: Setup for ST350 with sources and absorber kit. 
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Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60 (You want to 

measure counts per minute (cpm), so 60 seconds means the number of counts is 

also the cpm). 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place one of the half-sources on the sample tray with the blank disc.  Insert 

this into one of the upper shelves to take data.  Click on the green diamond to begin 

taking data.  Record the number of counts as r1. 

7. Replace the blank disc with the second half-source and start a second run.  Click on 

the green diamond to take data.  Record this number of counts as r3. 

8. Replace the first half-source with the blank disc and start a third run.  Click on the 

green diamond to take data.  Record this number of counts as r2. 

9. Remove both sources and replace the sample tray.  (Use two blank discs if 

available.)  Take data for a background count by clicking on the green diamond. 

10. Save your data either onto disk or into a data table. 



39 

 

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish.  Expand the 

A and E columns. 

2. In cell G9, enter the word Corrected.  In cell G10, enter the word Counts. 

3. In cell G13, enter the formula =C13-$C$12 and copy this down to cells G14 and G15 

4. In cell E2, enter “Resolving Time =” . 

5. In cell F2, enter the equation =(G13+G15-G14)/(2*G13*G15). 

6. In cell H9, enter the word New and in cell H10 enter Counts. 

7. In cell H13, enter the formula =G13/(1-(G13*$F$2)) and copy this formula down to 

cells H14 and H15. 

8. In cell I9, enter the words % Counts and in cell I10 enter Missing. 

9. In cell I13, enter the formula =(ABS(H13-G13)/H13)*100 and copy the formula into 

cells I14 and I15.   

10. Save your worksheet or print it out per your teacher’s instructions. 

 

Post-Lab Questions: 

1. What is your GM tube’s resolving (or dead) time?  Does it fall within the accepted 1 

µs to 100 µs range?   

Answer: These are the students’ final results.  The range check should point out 

any errors made in the calculations. 

2. Is the percent of correction the same for all your values?  Should it be?  Why or why 

not? 

Answer: No.  They should not all be the same due to the fact that at higher count 

rates, the chances of two radiation particles or rays arriving at the same time is 

much higher than at smaller count rates. 
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 Data Sheet for Resolving Time Lab 
     

 Tube #:  Run Duration:  

 Source:  (Time)  

     

  Counts Corr. Counts % Missing 

 r1:    

 r2:    

 r3:    

     
 T:    
     
 Tube #:  Run Duration:  

 Source:  (Time)  

     
  Counts Corr. Counts % Missing 

 r1:    

 r2:    

 r3:    

     
 T:    

 

 

Name:      Lab Session:     
Date:       Partner:      
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Lab #5: Geiger Tube Efficiency 

Objective:  

 The student will determine the efficiency of a Geiger-Muller counter for various 

types of radiation. 

 

Pre-lab Questions: 

1. How can you determine the activity of a radioactive source?  Find the activity of the 

three sources you will use in this experiment. 

Answer:  Look at the label or ask the teacher.   

2. Do you expect efficiency to be good or bad for each of your sources?  (Consider 

real-world effects) 

Answer: Bad.  The detector only sees a small percentage of all the radiation 

released and then it may not detect it all.  Gamma sources will be the worse, 

because they are much more likely to pass through the GM tube’s gas without 

any ionization (through the photoelectric effect).    

 

Introduction: 

 From earlier experiments, you should have learned that a GM tube does not 

count all the particles, which are emitted from a source, i.e., dead time.  Some particles 

do not strike the tube at all, because they are emitted uniformly in all directions from the 

source.  In this experiment, you will calculate the efficiency of a GM tube counting 

system for different isotopes by comparing the measured count rate to the total 

disintegration rate.   

 To find the total disintegration rate, change from microCuries (µCi) to 

disintegrations per minute (dpm), because that is equivalent to the counts per minute 

from the GM tube.  The conversion factor is: 

dpmCiordpmCi 612 1022.211022.21 ×=×= µ .                    (1) 

Multiply this by the activity of the source and you have the expected counts per minute 

of the source.  Then you can find the efficiency of the GM tube, by using a fairly simple 
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formula.  You want to find the percent of the counts you observe versus the counts you 

expect, so you can express this as  

( )
CK

r
Efficiency

100
% = .           (2) 

In this formula, r is the measured activity in cpm, C is the activity of the source in µCi, 

and K is the conversion factor from Equation 1. 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 

Figure 1 – Setup for ST350 with sources and absorber kit 

• Radioactive Source (one each of an alpha, beta, and gamma sources – we 

recommend Po-210, Sr-90, Co-60 respectively.) – shown in Figure 2. 
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Figure 2 – Kit with one each of an alpha emitter, beta emitter, and gamma emitter  

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 
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900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place one of the radioactive sources in the top shelf and begin taking data 

(click on the green diamond).  

7. Repeat this for each of your other two sources.  Remember that the first run is a 

background number. 

8. (OPTIONAL) From the Preset menu, change the Preset Time to 300, and take data 

for all three sources again. 

27. Save your data to disk or to a data table before exiting the ST350 program.   

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2 enter constant, K = and in cell F2 enter 2.20E6 (or 0.00000220).  In cell E3 

enter (conversion from µCi to dpm).  (To create the µ, you need to change to the 

symbol font and then simply type the letter m.  Don’t forget to switch back to your 

original font when done.) 

3. In cell E5 enter Dead Time = and in cell F6 enter the dead time for your GM tube.   

4. In cell G10, enter Activity (µCi).  Then cells G13-G17, enter the activities of the 

sources used.  (Remember to not enter one for the background counts row.) 

5. In cell H9 enter Res. Corr. and in cell H10 enter Counts.  In cell H13, enter the 

formula =C13/(1-(C13*$F$6)) to corrected for resolving time.  Copy this formula to 

cells C14 and C15.  Then, in cell H16, enter the formula  

=(C16/5)/(1-((C16/5)*$F$6)) and copy to cells H17 and H18.  This changes the five 

minute counts to counts per minute, and corrects them for resolving time.  

6. In cell I9 enter Bkgd Corr. and in cell I10 enter Counts.  In cell I13, enter the formula 

=H13-$C$12.  Copy this formula to the other cells.  (You may have to adjust the 
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formula if you took a five minute background count, but don’t forget to convert it to 

cpm by dividing by 5.) 

7. In cell J10, enter % efficiency.  In cell J13, enter the formula =(I12*100)/(G12*$F$2) 

and copy it to all the relevant cells. 

8. Copy your results to your data table or print out a hard copy if you need to hand one 

in attached to a lab report 

 

Conclusions: 

 Are your results reasonable?  How do you know?  You should have numbers 

above zero but below 10 if you performed the experiment correctly.  Answer the post-

lab questions to help you form a conclusion from your results. 

 

Post-Lab Questions: 

1. Is the efficiency you calculated for each isotope valid only for that isotope?  

Explain your answer. 

Answer: Yes, the energies and radiation released will be different for each 

isotope.  However, it should be consistent for the same isotopes. 

2. If a different shelf is used, will the efficiency change?  Explain your answer. 

Answer:  Yes, because less counts will be received due to absorption by 

the air between the source and GM tube.  (Only true for alpha and beta 

particles.) 

3. The radius of the GM tube’s window is 3.5 cm.  The source is 3 cm from the 

GM tube.  Compare the surface area of a sphere 3 cm from the source to the 

area of the GM tube’s window.  (Hint: find the ratio)  How is this related to this 

experiment?  Can this tell you if your results are reasonable? 

Answer: 
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efficiency that that GM tube can have.  The students’ results should all be 

below this value.   
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4. (Correlates if five minute and one minute runs were taken.)  Are the 

efficiencies different?  How different?  Why? 

Answer: Yes, they are.  Difference depends on results.  They are different, 

because with more data taken in the longer run, there is less experimental 

error. 
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   Data Sheet for GM Tube Efficiency Lab   

      

 Tube #:   Run Duration:  

 Dead Time:   (Time)  

      

 Source Counts Corr. Counts Expect. Counts Efficiency 

      
      
      
      
      
      
      
      
 Tube #:   Run Duration:  

 Dead Time:   (Time)  

      

 Source Counts Corr. Counts Expect. Counts Efficiency 

      
      
      
 

 

 

Name:      Lab Session:     
Date:       Partner:      
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Lab #6: Shelf Ratios 

Objective:  

 The student will investigate the relationship between the distance and intensity of 

radiation.  The student will also measure the shelf ratios of the sample holder. 

 

Pre-lab Questions: 

1. Does radiation gain intensity or lose intensity as a source gets farther from a 

detector? 

Answer: Loses intensity, similar to sound or light intensity. 

2. How is radiation emitted from a radioactive source?  (Hint: Think of the sun) 

Answer: Radially outward or spherically symmetric.  That is out in all directions 

like from a sphere. 

 

Introduction: 

 Although radiation is emitted from a source in all directions, only a small part 

actually enters the tube to be counted.  This fraction is a function of the distance, h, 

from the point source of radiation to the GM tube.  See Figure 1 for a picture of a 

“sphere” which represents the radiation emitted radially from the radioactive source.  It 

can also be observed the small fraction of the “sphere” that will enter the window of 

Geiger counter, which is represented by the triangle of sides d and height h.  If the 

source is moved further away from the tube, the amount of radiation entering the tube 

should decrease.  This is due to the fact that the triangle’s height will increase, and the 

triangle will represent less and less of the “sphere” of radiation.  
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Figure 1: Influence of the source-to-window 

distance on the observed count rate. 

 

As a beta source is moved away from the detector, activity will decrease more 

rapidly than predicted by the inverse square law because beta particles are also 

absorbed by air.  The problem presented by this extra absorption is placing the source 

close enough to get a good fraction of the radiation in the window of the GM tube, but 

also not placing the source too far away where absorption becomes a important factor 

to consider.   

 It is sometimes convenient to take advantage of this change in activity with 

distance by moving less active samples toward the counter and samples which are too 

active away from the tube in order to obtain suitable counting rates.  This is the reason 

that tube stands are made with multiple shelves. 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 

 



50 

 

Figure 1 – Setup for ST350 with sources and absorber kit 

• Radioactive Source (beta sources – we recommend Tl-204 or Sr-90) – green 

source in Figure 1. 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 
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3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 30. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the top shelf and begin taking data (click on the 

green diamond).  In this position, the source is 2 cm from the GM tube’s actual 

detector components. 

7. Move the source down one shelf each time and take another run.  You should see 

the data accumulating in the Data window.  After all ten shelves have been used, 

save the data onto disk or record in a data table.  Remember that the first run is a 

background number. 

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In Cell E2 enter Dead Time = and in cell F2 enter the dead time for your GM tube.   

3. In cell G9 enter Res. Corr. and in cell G10 enter Counts.  In cell G13, enter the 

formula =C13/(1-(C13*$F$2)) and copy this to the rest of the cells corresponding to 

counts in column C.  Do not correct the background counts. 

4. In cell H9 enter Bkgd Corr. and in cell H10 enter Counts.  In cell H13, enter the 

formula =G13-$C$12 and copy this to the rest of the cells corresponding to counts in 

column G. 

5. In cell I9 enter Shelf and in cell I10 enter Ratio.  In cell I13, enter the formula 

=I13/$I$14 and copy this to the rest of the cells corresponding to counts in column H.  

This should give you a shelf ratio of 1.00 for the second shelf.  This is our reference 

point.    

 

Conclusions: 
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 You should see a decrease in your values as you move away from the source.  If 

you do not, this may be caused by statistical fluctuations in your counts.  Why?   

 

Post-Lab Questions: 

1. Does the shelf ratio depend on the identity of the sample used? 

Answer:  Yes, there are different shelf ratio sets for different isotopes, 

because the different forms (and energies) of radiation react differently to 

the amount of air continually added between the source and GM tube. 

2. If the experiment is repeated with a gamma or alpha source, what differences 

would you expect? 

Answer: The gamma ratios would almost all be near 1, since the gammas 

are not attenuated by air.  The alphas on the other hand, are seriously 

attenuated by air and would quickly drop off to zero. 

3. Why is the second shelf the reference shelf? 

Answer: The second shelf is the reference shelf because it receives a high 

count rate but not too high.  You must correct for dead time but it is not as 

significant of a correction as the top shelf. 

 

 

 

 

 

 

 

 

 

 

 

 



53 

 

 

 

 

 

 

   Data Sheet for Shelf Ratios Lab   

      

 Tube #:   Run Duration:  

 Dead 
Time: 

  (Time)  

      

 Shelf # Counts Corr. Counts Shelf Ratio  

 1     
 2   1.00  
 3     
 4     

 5     

 6     

 7     

 8     

 9     

 10     

 

 

 

Name:      Lab Session:     
Date:       Partner:      



54 

 

Lab #7: Backscattering 

Objective:  

 The student will investigate the relationship between absorber material (atomic 

number) and backscattering in Part One.  In Part Two, The student will investigate the 

relationship between absorber thickness and backscattering 

 

Pre-lab Questions: 

1. Calculate what percentage of the entire “sphere” surrounding the source does the 

GM window occupy. 

Answer: See the Efficiency lab -> 34% 

2. Backscattering does have dependencies on atomic number and on thickness.  Does 

either one dominant the amount of backscattering versus the other?  What kind of 

dependence do you predict for each (direct, inverse, inverse square for example – 

be descriptive)? 

Answer:  Check the reasoning, but the correct answers are that there is a direct, 

linear relationship between backscattering and atomic number.  There is a direct, 

logarithmic (saturation level present) relationship between thickness and 

backscattering.  

 

Introduction: 

 Radiation is emitted from a source in all directions.  The radiation emitted within 

the angle subtended by the window of the GM tube is the only radiation counted.  Most 

radiation is emitted away from the tube but it strikes matter.  When it does so, the 

direction of its path may be deflected.  This deflection is known as scattering.  Most 

particles undergo multiple scattering passing through matter.  Beta particles especially 

may be scattered through large angles.  Radiation scattered through approximately 

1800 is said to be backscattered.  For Geiger counters, the fraction of radiation emitted 

away from the GM tube that strikes the material supporting the sample.  It is deflected 

toward the tube window and is counted. 
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 A beta particle entering matter undergoes a series of collisions with mostly nuclei 

and sometimes orbital electrons.  A collision between particles does not occur in the 

same manner we picture them in the macroscopic world.  There are very little contact 

collisions, but instead the term, collision, refers to any interaction, coulombic or 

otherwise.  (A coulombic interaction is an electrical attraction or repulsion that changes 

the path of the particle’s motion.)  A collision may be elastic or inelastic, but in either 

case the result is not only a change in direction but usually a decrease in the energy of 

the beta particle as well (inelastic). 

 In the first part of the experiment, we will investigate the effect of the size of the 

nucleus on backscattering since this would seem most likely effect the number of 

backscattered beta particles.  This can be determined by using absorbers as backing 

materials.  Even though the metal pieces you will use are called absorbers, in this 

experiment, they will also be used to deflect radiation upward into the GM tube.  To 

eliminate any other effects, the absorbers will be the same thickness but different 

atomic number (and thus different sized nuclei).  In the second part of the experiment, 

you will use absorbers of the same material (atomic number) and different thickness.  

This is a common experimental technique, fixing one variable and varying another to 

investigate each one individually  

 Normally when we think of thickness, we think of linear thickness that can be 

measured in a linear unit such as inches or centimeters.  However, in nuclear and 

particle physics, thickness refers to areal thickness.  This is the thickness of the 

absorbers in mg/cm2.  The absorptive power of a material is dependent on its density 

and thickness, so the product of these two quantities is given as the total absorber 

thickness, or areal thickness.  We determine areal thickness with the equation: 

Density (mg/cm3) X thickness (cm) = Absorber thickness (mg/cm2).         (1) 

You will determine the dependence that absorber thickness has on backscattering. 
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Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) 

Figure 1 – Setup for ST350 with sources and absorber kit 

 

• Radioactive Source (THIN* beta emitter)  

• Part I: Backscatter Absorber Kit – Plastic (poly-carbonate), Aluminum, 

Copper, Tin, Lead, and “an unknown” Discs 

• Part II: (Regular) Absorber Kit – the Aluminum and Lead pieces will be used. 

(Shown in Figure 1.) 

 

                                                             
* A thin source is required to reduce self-absorption by the source.  The betas sent downward that are scattered back 
up toward the GM tube may pass through the source again.   
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Procedure: 

Part I – Atomic Number Dependence  

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the second shelf from the top and begin taking 

data (click on the green diamond).   

7. Place an absorber piece in the source holder and place the source directly on top of 

it.  Take data by clicking on the green diamond. 

8. Repeat this for all of the various absorbers including the unknown. 

9. Record the data to a file on disk or into a data table. 

 

Part II – Thickness Dependence  

1. Set-up the GM tube again if you are continuing this lab at a later time.  From the 

Preset menu, set Runs to zero and set Preset Time to 60. 
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2. (Do only if doing this part at a later time.) First do a run without a radioactive source.  

This will determine your background level.  Click the green diamond to begin taking 

data. 

3. Next, place the radioactive source in the second shelf from the top and begin taking 

data (click on the green diamond).   

4. Place the source directly on top of one of the absorbers.  Take data by clicking on 

the green diamond. 

5. Place the source on a different absorber and insert into the second shelf.  Click on 

the green diamond to begin taking data. 

6. Repeat for at least three other absorber thicknesses. 

7. Record the data to a file on disk or into a data table. 

 

Data Analysis: 

Part I – Atomic Number Dependence 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2, enter “Dead Time =” and in cell F2 enter the dead time determined for 

your GM tube.   

3. In cell G9 enter Dead Corr. and in cell G10 enter Counts.  In cell G13, enter the 

formula =C13/(1-(C13*$F$2)).  Copy this down for the cells that have counts in 

column C.  This corrects the counts for resolving (dead) time but not the background 

counts, because any correction for them would be less than one count. 

4. In cell H9 enter Bkgd Corr and in cell H10 enter Counts.  In cell H13, enter the 

formula =G13-$C$12.  Copy this down for the cells that have counts in column G.  

This corrects for background.  Is background significant?  Can you back up your 

answer numerically? 

5. In cell I9 enter Atomic and in cell I10 enter Number.  In cell I13 and below, enter the 

atomic numbers for the absorbers you used to get obtain the corresponding counts.  

(Plastic is poly-carbonate** – Z = 6, Aluminum – Z = 13, Copper – Z = 29, Tin – Z = 

50, and Lead – Z = 82) 

                                                             
** Plastic is effective carbon because that is the dominating element in this material. 
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6. To double-check the general result of our data that we will graph below, we will 

calculate the percentage of counts that were due to backscattering and compare that 

to the Z values.  To calculate the percent of counts from backscattering, use the 

following formula 100% ×






 −
=

o

o

r

rr
back , where r is the corrected count rate (cpm) 

and ro is the count rate without any absorber present.  To do this in Excel, in cell J9 

enter Percent and cell J10 Backscatt.  In cell J13, enter the formula  

=((H13-$H$13)/$H$13)*100.  This should give 0 for cell J13 but not for the rest. 

7. Next, make a graph of Corrected Counts vs. Atomic Number.  Start with the Chart 

Wizard either by choosing Chart from the Insert Menu or pressing its icon on the top 

toolbar. 

8. Select the XY (Scatter) Plot from Plot Types and click on Next. 

9. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the Bkgd Corr. Counts (column H) and Atomic Number columns of data 

(column I).  [Use the Ctrl key to highlight more than one column of data.]  When you 

have done this, hit the Enter key.  The other way to do this is to choose the Series 

tab.  Click remove to eliminate two of the three series listed as default values.  Now 

using the cursor button to the right of the X-Values window, highlight the Atomic 

Number values in the I column.  Using the cursor button to the right of the Y-Values 

window, highlight the Bkgd Corr. Corrected Counts values in the H column.  When 

either one of these methods is completed, click on Next. 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

11. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 
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12. Adjust the size of the graph for your preference (or the instructor’s).  You may also 

wish to adjust the scales on one or more of the axes.  Again, this is a preference 

issue. 

13. Right click on one of the data points and from the menu that appears, choose Add 

Trendline.  Make sure that the Linear option is chosen (should be darkened).  Then 

click on the Options tab and check the boxes for Display equation on chart and 

Display R-squared value on chart.  This will make the equation of the best fit line 

appear as well as a number that represents the percent of linearity of the data.   

 

Part II – Thickness Dependence 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2, enter “Dead Time =” and in cell F2 enter the dead time determined for 

your GM tube.   

3. In cell G9 enter Dead Corr. and in cell G10 enter Counts.  In cell G13, enter the 

formula =C13/(1-(C13*$F$2)).  Copy this down for the cells that have counts in 

column C.  This corrects the counts for resolving (dead) time but not the background 

counts, because any correction for them would be less than one count. 

4. In cell H9 enter Bkgd Corr and in cell H10 enter Counts.  In cell H13, enter the 

formula =G13-$C$12.  Copy this down for the cells that have counts in column G.  

This corrects for background. 

5. In cell I9 enter Thickness and in cell I10 enter (in).  In cell I13 and below, enter the 

thickness of the absorbers (0.32, 0.063, or 0.125 inches) for the aluminum and 

lead***. 

6. Calculate the percentage of counts that were due to backscattering.  In cell J9 enter 

Percent and cell J10 Backscatt.  In cell J13, enter the formula  

=((H13-$H$13)/$H$13)*100.  This should give 0 for cell J13 but not for the rest.  

7. Next, make a graph of Corrected Counts vs. Thickness.  Start with the Chart Wizard 

either by choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 

                                                             
*** Lead has an absorber that is 0.064 inches thick instead of the listed 0.063 inches.  Make sure you enter it 
correctly. 
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8. Select the XY (Scatter) Plot from Plot Types and click on Next. 

9. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the Bkgd Corr. Counts (column H) and Thickness columns of data 

(column I).  [Use the Ctrl key to highlight more than one column of data.]  When you 

have done this, hit the Enter key.  The other way to do this is to choose the Series 

tab.  Click remove to eliminate two of the three series listed as default values.  Now 

using the cursor button to the right of the X-Values window, highlight the Thickness 

values in the I column.  Using the cursor button to the right of the Y-Values window, 

highlight the Bkgd Corr. Corrected Counts values in the H column.  When either one 

of these methods is completed, click on Next. 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

11. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

12. Adjust the size of the graph for your preference (or the instructor’s).  You may also 

wish to adjust the scales on one or more of the axes.  Again, this is a preference 

issue. 

13. Right click on one of the data points and from the menu that appears choose Add 

Trendline.  Make sure that the Linear option is chosen (should be darkened).  Then 

click on the Options tab and check the boxes for Display equation on chart and 

Display R-squared value on chart.  This will make the equation of the best fit line 

appear as well as a number that represents the percent of linearity of the data.   

 

Conclusions: 

 What is your conclusion about the dependence of backscattering on atomic 

number?  How about on thickness? 
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Post-Lab Questions: 

1. Justify your answers to the questions about the dependences of 

backscattering. 

Answer:  Students must reference their data and/or graphs to back up any 

statements. 

2. Do your % backscattering calculations confirm your results? 

Answer: The same trends should be present.  Again, it depends on the 

student’s results. 

3. What element (or material) is the unknown absorber? 

Answer:  Steel, but it mostly iron, so the students should predict the 

element Fe or one close to it on the periodic table depending on their 

experimental error. 

4. What would be the predicted count rate for a uranium disk of the same size 

as those used in Part I?  How about if it was ¼ in. thick (qualitative answer, 

higher or lower)?  Show your work and explain any reasoning. 

Answer:  Student should find the equation of the line from Part I of the lab, 

and use that with Z=92 (uranium) to make the prediction.  If you make it ¼ 

in. thick, then you most likely get more backscattering.  That is, if you 

haven’t already saturated the backscattering with the earlier thickness. 
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   Data Sheet for Backscattering Lab 
        

 Tube #:   Run Duration:    

 Dead Time:   (Time)    

        

  Part I      

 Element (Z) Counts Corr. Counts % Backscat.    

        

        

        

        

        

        

        

        

        

        

        

        

        

        

 
 

       

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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   Data Sheet for Backscattering Lab 
        

 Tube #:   Run Duration:    

 Dead Time:   (Time)   

  Part II      

 Thickness Counts Corr. Counts % Backscat.    

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #8: Inverse Square Law 

Objective:  

 The student will verify the inverse square relationship between the distance and 

intensity of radiation.   

 

Pre-lab Questions: 

1. Write a general mathematical expression for an inverse square law. 

Answer:  
2

1

d
I ∝ where I is the intensity and d is the distance in this example.  

Most people write them as 
2d

k
I = , where k is called a constant of proportionality.  

It sets the quantities I and 1/d2 equal. 

2. What are other examples of inverse square laws? 

Answer: Gravity, electric force, light, sound are just a few. 

 

Introduction: 

 As a source is moved away from the detector, the intensity, or amount of 

detected radiation, decreases.  You may have observed this effect in a previous 

experiment, Shelf Ratios Lab.  If not, you have observed a similar effect in your life.  

The farther you move away from a friend, the harder it is to hear them.  Or the farther 

you move away from a light source, the harder it is to see.  Basically, nature provides 

many examples (including light, sound, and radiation) that follow an inverse square law.   

 What an inverse square law says is that as you double the distance between 

source and detector, intensity goes down by a factor of four.  If you triple the distance, 

intensity would decrease by a factor of nine.  If you quadruple the distance, the intensity 

would decrease by a factor of 16, and so on and so on.  As a result, if you move to a 

distance d away from the window of the GM counter, then the intensity of radiation 

decreases by a factor 1/d2. 
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Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 

Figure 1 – Setup for ST350 with sources and absorber kit 

• Radioactive Source (beta sources – we recommend Tl-204 or Sr-90) – one of 

the green sources shown in Figure 1. 

 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-
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350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 30. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the top shelf and begin taking data (click on the 

green diamond).  In this position, the source is 2 cm from the GM tube’s actual 

detector components. 

7. Move the source down one shelf each time and take another run.  You should see 

the data accumulating in the Data window.  After all ten shelves have been used, 

save the data onto disk or record in a data table.  Remember that the first run is a 

background number. 

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. Go cell G9 and insert the word True.  Go to cell G10 and insert the word Counts.  In 

cell H10, insert “Distance (cm)”.  In cell I10, insert “Distance (m)”.  In cell J10, insert 

“1/d^2”. 

3. In cell G13, insert the formula =C13-$C$12.  (The $ sign keeps cell C12 as a fixed 

quantity when we copy this cell.)  Copy this cell into cells G14 down to G22.  This 

can be down in two ways.  The first way, you start with the cursor in the G13 cell.  



68 

 

From the Edit menu, choose Copy.  Then highlight cells G14 through G22.  From the 

Edit menu, now choose Paste.  Check a cell to verify that this has worked.   A 

second way to copy the formula is starting with your cursor in cell G13.  Then with 

your cursor move to the lower right corner of the cell.  When the cursor becomes a 

crosshairs, you can then move the cursor down and see subsequent cells become 

enclosed by a faint outline.  That means the formula in the original cell will copy to 

the other cells. 

4. In cell H13, insert the distances.  They should begin with 2 and increase by one until 

11 is reached.   

5. In cell I13, insert the formula =H13/100.  Copy this formula in each cell from I14 

down to I22. 

6. In cell J13, insert the formula =1/(I13*I13) or =1/(I13^2).  Either form gets you the 

inverse square of the distance.  Copy this formula in the cells down from J14 to J22. 

7. Next, make a graph of Counts vs. 1/d2.  Start with the Chart Wizard either by 

choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 

8. Select the XY (Scatter) Plot from Plot Types and click on Next. 

9. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

True Counts and 1/d2 columns of data.  When you have done this, hit the Enter key.  

The other way to do this is to choose the Series tab.  Click remove to eliminate two 

of the three series listed as default values.  Now using the cursor button to the right 

of the X-Values window, highlight the 1/d2 values in the J column.  Using the cursor 

button to the right of the Y-Values window, highlight the True Counts values in the H 

column.  When either one of these methods is completed, click on Next. 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

11. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 
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12. Position your cursor directly over one of the data points on your graph.  Then click 

the right button on the mouse and watch a small menu appear.  Choose the Add 

Trendline option.  You may click OK here or if you want more information choose the 

Options Tab.  There you may click in the boxes for Display Equation on Chart (for 

the equation of the line in slope-intercept form to appear on the graph) or on Display 

R-squared value on chart (this gives a decimal representation of the percentage 

completely linear the data is).   

 

Conclusions: 

 Use your graph to determine if the data does indeed obey inverse square law. 

 

 

Post-Lab Questions: 

1. Does your data follow Excel’s ® best fit line?  If not, why?   

Answer:  It should but check their results for any abnormalities. 

2. Does this verify the inverse square law, explain? 

Answer:  Yes, it can.   
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   Data Sheet for Inverse Square Law Lab   

       
 Tube #:   Run Duration:   

 Dead Time:   (Time)   

       
       
 Counts Corr. Counts Distance  1/d^2   

       
       
       
       
       
       
       
       
       
       
       
       
       
       

       

       

 Counts Corr. Counts Distance  1/d^2   

       
       
       
       
       
       
       
       
       
       
       
       

 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #9: Range of Alpha Particles 

Objective:  

 The student will determine the range of an alpha particle in air, and consequently 

the alpha particle’s energy. 

 

Pre-lab Questions: 

1. What is an alpha particle?  How and why are they emitted? 

Answer: An alpha particle is a helium nucleus (2 protons and 2 neutrons).  They 

are emitted when a nucleus becomes unstable.  The alpha particle actually 

“tunnels” through the potential that holding it in the nucleus originally.  They are 

emitted with a range of 5-6 MeV, but at one specific value (in that range) for a 

specific isotope.     

2. What everyday material can block alpha particles? 

Answer: Paper, skin, air, etc. 

3. Do you predict the range to be long or short?  Why? 

Answer:  Short, because thin materials even air can block alpha particles. 

 

Introduction: 

 We know that particles that enter matter lose their energy1 via collisions with 

atoms in the matter.  So, a natural question would be, how far will the particle travel in 

the matter before it loses all of its energy?  This quantity is called the range of a 

particle, and depends on the type of material, particle type, and its energy.  Normally, 

we assume that the energy loss is continuous (particle loses some energy for each 

amount of distance it travels), the range will be a certain distance for the same particles 

with identical initial energies passing through the same type of material.  In this 

experiment, you will look at alpha particles passing through air. 

The alpha particle (α) is a helium ion (+2), which is composed of two protons (p) 

and two neutrons (n).  Ramsay and Soddy observed that helium is constantly being 

                                                             
1 When dealing with particles, we ignore potential energies from bonding mainly because the size is so small.  The 
term energy refers solely to the kinetic energy of the particle. 
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produced from radium and that radioactive minerals invariably contain helium.  

Rutherford and Royds later showed that alpha particles form neutral helium atoms when 

they lose their kinetic energy.  In the process, each alpha particle gains two electrons 

from the surrounding material.   

Alpha particles emitted from a particular species of nucleus are mono-energetic; 

alphas from the same species have the same energy.  The energy of most alphas falls 

in the range between 3 and 8 MeV.  By comparison, chemical reactions have energies 

of 5 to 30 eV per molecule. 

 The velocity of an alpha particle upon emission from the nucleus depends upon 

the radioelement of its origin.  The alpha particle has great ionizing power, but very little 

penetrating power.  (If it enters the GM tube, then it will ionize the gas and be detected 

unless it is the dead time.)  Its energy is approximated by its range in air in the equation: 

5.1+≅ RE ,                      (1) 

where R is the range in air of the alpha particle in centimeters and E is the energy of the 

alpha particle in MeV. 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 1. 
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Figure 1 – Setup for ST350 with sources and absorber kit 

• Radioactive Source (alpha emitter – Po-210 is best for this experiment – the 

red source shown in Figure 1) 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 
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Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the top shelf from the top and begin taking data 

(click on the green diamond).   

7. Move the source down and take data again. 

8. Repeat this until you repeatedly get counts approximately equal to your background.  

(This means you will take data at approximately the sixth or seventh shelf at the 

most.) 

9. Save your data either to disk or into a data table.  

 

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2, enter “Dead Time =” and in cell F2 enter the dead time determined for 

your GM tube.   

3. In cell G9 enter Res. Corr. and in cell G10 enter Counts.  In cell G15, enter the 

formula =C15/(1-(C15*$F$2)) and copy that formula down to cell G32.  You do not 

do this for the background counts (mainly because the correction for them is in the 

thousandth place).    In cell G12, enter the formula =C12 and copy that into cells 

G13 and G14. 

4. Now, average the three runs you preformed on each of the shelves.  In cell H9 enter 

Average and in cell H10 enter Counts.  In cell H12, enter =SUM(G12:G14)/3.  In cell 
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H13, enter =SUM(G15:G17)/3.  Repeat this pattern until you average all your groups 

of runs. 

5. Next, correct for the average background.  In cell I9 enter Bkgd. Corr. and in cell I10 

enter Counts.  In cell I12 enter the formula =H12-$H$12.  Copy this down for all 

averaged counts you have.   

6. Finally, we need to add the distances to the chart.  In cell J10, enter Distance (cm).  

Starting in cell J13, enter 2.  Then in cell J14, enter the formula =J13+1 and copy 

this down for all the distances you took data.   

7. A graph may not be too useful here because of lack of measurements above 2 cm.  

In addition, you would like measurements in increments less than 1 cm.  Look at 

your data.  Where is there a sudden fall-off in the counts per minute (going from 

thousands to tens)?  Where does the data dip below the x-axis?  Use extrapolation 

to guess where these two situations occur (i.e., 2.7 cm because it fell in-between 2 

cm and 3 cm but seems closer to 3 cm).  Average these two numbers and that gives 

the mean range of your alpha particles.   

8. Use that number as R in Equation (1) to find the energy of your alpha particles.  

Compare this value of E to the expected value, 5.34 MeV, by finding the percent 

error.  100% ×






 −
=

ltheoretica

ltheoreticameasured
error  

OPTIONAL: 

9. Make a graph of Corrected Counts per Minute vs. Distance.  Start with the Chart 

Wizard either by choosing Chart from the Insert Menu or pressing its icon on the top 

toolbar. 

10. Select the XY (Scatter) Plot from Plot Types and click on Next. 

11. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the Average Counts (column I) and Distance (column J) columns of data.  

(Use the Ctrl key to highlight more than one column of data.)  When you have done 

this, hit the Enter key.  The other way to do this is to choose the Series tab.  Click 
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remove to eliminate two of the three series listed as default values.  Now using the 

cursor button to the right of the X-Values window, highlight the Distance values in 

the J column.  Using the cursor button to the right of the Y-Values window, highlight 

the Average Counts values in the I column.  When either one of these methods is 

completed, click on Next. 

12. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

13. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

Conclusions: 

 What you should see in a graph your data (if you made one) is that as the data 

approaches the range, it does not drop immediately to the background level directly at 

the range value.  Instead, the curve slopes down over a certain interval of distances.  

This is because our original assumption of energy loss being continuous is not quite 

accurate.  Not every identical particle will have identical energy loss.  That is because, 

every particle suffers a different number of collisions when passing through matter and 

thus have slightly different energy losses.  This means that energy loss is statistical in 

nature.   

If you measure an ensemble (or group) of identical particles passing through the 

same sample, then you will a statistical distribution of ranges centered about some 

mean value, the mean range.  This phenomenon is known as range straggling.  This 

means some alpha particles are stopped with less air than others, because of the  

Figure 2: Alpha particle range straggling is shown.  The intensity of alpha 

particles drops off over a small range and not immediately at one value. 
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difference in the number of collisions it has with air molecules.  

 An example of a plot of alpha range straggling is shown in Figure 2.  You can see 

that at that point the counts first drop off sharply to the left of the mean range, which is 

one point you can identify on the graph from your data.  Then there is a sudden drop off 

to zero to the right of the mean range where the counts above background are zero.  

This is the other point you should found.  Then, the point in the point in the middle of 

these other two will be your mean range.   

  

Post-Lab Questions: 

1. Compare your results of range and energy to those values that can be found 

in a handbook (see Figure 3).  Results? 

Answer: The amount of error will depend on the students’ results. 

Figure 3: Plot of Alpha particle range versus energy in MeV. 

 

2. How far away should a person stand to not receive any alpha particles that 

are emitted from a nucleus at 8 MeV? 

Answer: Greater than 7.3 cm away – because this value is only the mean 

range.  Practically, 9 cm was seem sufficient. 

3. How reliable is your data?  In other words, is the percent error high?  (Explain 

why you think it is high)  If it is high, is that OK?  Why? 

Answer: The error should pretty high because of the few measurements 

that can actually be taken with the equipment.   It is an expected result. 
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 Data Sheet for Alpha Range Lab 
      

Tube #:   Run Duration:   

Dead Time:   (Time)   

      

      

Shelf Counts Corr. Counts d (cm)   

      

      

      

      

      

      

      

      

Fall off starts about:  Cm E = R + 1.5  

Fall off ends about:  Cm E = MeV  

Center of Fall off:  Cm Lit. Value: E= MeV  

   % Error =   

      

 
 
 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #10: Absorption of Beta Particles 

Objective:  

 The student will investigate the attenuation of radiation via the absorption of beta 

particles. 

 

Pre-lab Questions: 

1. How does activity of a source vary with distance?   

Answer: Inverse Square Law.  Intensity decreases as the square of the distance. 

2. How do you predict activity with vary with increasing absorber thickness, when an 

absorber is placed between the source and window of the GM tube? 

Answer: There will be a decrease, specifically though there is an exponential 

decrease. 

 

Introduction: 

 Beta particles are electrons that are emitted from an atom when a neutron 

decays by the weak force.  The neutron (n) becomes a proton (p), an electron (e-), and 

an anti-neutrino (ν )1.  When an electron originates in the nucleus, it is called a beta 

particle.   

                      ν++→ −epn                                                       (1)                

 Unlike alpha particles which are emitted from the nucleus with the same energy 

(~5 MeV), beta particles are emitted with a range of energies lying between 0 MeV and 

the maximum energy for a given radioactive isotope.  The velocity of a beta particle is 

dependent on its energy, and velocities range from zero to about 2.9 x 108 m/s, nearly 

the speed of light.  So the beta particles do not all have the same kinetic energy and 

thus they do not all have the same range.  When the range varies over different values, 

this is called range straggling.  It represents the different energy losses all of the beta 

particles have given their different initial values.  Figure 1 shows a typical absorption 

curve for beta particles, which illustrates the range straggling. 

                                                             
1 The purpose of the anti-neutrino’s creation is to carry off extra energy and momentum for the conservation of those 
quantities. 
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Figure 1: Typical absorption curve for beta particles. Plot is 

of intensity (activity) vs. absorber thickness (x) 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 2.  

Figure 2: Setup for ST350 with sources and absorber kit. 
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• Radioactive Source (beta emitter – any green source shown in Figure 2) 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the second shelf from the top and begin taking 

data (click on the green diamond).   

7. Place an absorber piece in the top shelf and take another run of data clicking on the 

green diamond to begin. 

8. Repeat this a minimum of 5 more times with absorbers of varying thickness.  

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell F6, enter “Dead Time =” and in cell G6 enter the dead time determined for 

your GM tube.   
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3. In cell G9, enter Thickness and in cell G10 enter mg/cm2.  Then starting in cell G13, 

enter the thickness for the absorbers used.  For cell G13, it should be zero (no 

absorber used).  In column F, under Notes, it may be convenient to enter the letters 

associated with the absorbers you used.  

4. In cell H9 enter “Corrected” and in cell H10 enter “Counts”.  Then starting in cell 

H13, enter the formula =C13/(1-(C13*$G$6)) to correct for the dead time of the GM 

counter.  Copy this formula down the column for all the data you collected. 

5. In cell I9 enter “Corrected” and in cell I10 enter “Counts”.  Then starting in cell I13, 

enter the formula =H13-$C$12 to correct for the background of the GM counter. 

Copy this formula down for all the data you have. 

6. In cell J9 enter “Natural Log” and in cell J10, enter “of Counts”.  Then in cell J13, 

enter the formula =LN(I13) and copy this formula down for all the data you have. 

7. Next, make a graph of Corrected Counts vs. Thickness.  Start with the Chart Wizard 

either by choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 

8. Select the XY (Scatter) Plot from Plot Types and click on Next. 

9. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the second Corrected Counts (column I) and Thickness columns of data.  

(Use the Ctrl key to highlight more than one column of data.)  When you have done 

this, hit the Enter key.  The other way to do this is to choose the Series tab.  Click 

remove to eliminate two of the three series listed as default values.  Now using the 

cursor button to the right of the X-Values window, highlight the Thickness values in 

the G column.  Using the cursor button to the right of the Y-Values window, highlight 

the Corrected Counts values in the I column.  When either one of these methods is 

completed, click on Next. 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 
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11. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

 

Conclusions: 

 You should be able to characterize the relationship between beta particle activity 

and absorber thickness. 

 

Post-Lab Questions: 

1. Is your data linear?  If not, what type of behavior does it exhibit? 

Answer: Not quite, it tails off when it reaches the background level.  That 

is, there is a minimum amount of counts always seen. 

2. What is the slope for your data?  How did you obtain it?  

3. What is the range of the beta particles, so that all of them stop? 

Answer:  Check students’ work.  The “maximum” range for beta particles 

is several millimeters of aluminum.  So one of the thicker aluminum 

absorbers will stop almost all of the beta particles (hard to stop all). 

4. Bremmsstrahlung (German for braking radiation) is the name given to x-rays 

produced by beta particles reacting with matter.  Was any bremmsstrahlung 

produced during the experiment?  Can it minimized?  

Answer:  Yes, there was.  Extra counts that should not be present (above 

background) with thicker aluminum absorbers are bremmstrahlung x-rays.  

The only practical way for students to minimize it would be to use lower Z 

materials with larger linear thicknesses.   
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  Data Sheet for Beta Absoprtion Lab 
      

Tube #:   Run Duration:   

Dead Time:   (Time)   

      

Counts Corr. Counts Thickness ln (Counts)   

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #11: Beta Decay Energy 

Objective:  

 The student will determine the maximum energy of decay of a beta particle. 

 

Pre-lab Questions: 

1. What is the decay mechanism for beta decay?  Why are there three decay 

products? 

Answer: Beta particles are produced when a neutron decays, and becomes a 

proton, electron (the beta particle), and an anti-neutrino.  There are three decay 

products to conserve mass, energy, and momentum. 

2. What are the units of thickness for an absorber?   

Answer: Thickness for an absorber is given in mg/cm2, that way density is taken 

into account. 

3. Why shouldn’t a beta source be placed below the third shelf?  Or above the second 

shelf?  

Answer: Below the second shelf, the counts drop a bit lower (inverse square law) 

than desirable, while above the second shelf there are too many counts. 

 

Introduction: 

 When beta particles are emitted from a nucleus, they are emitted over a wide 

range of energies.  (Recall that this is different from alpha particles, which are emitted 

monoenergetically.)  The maximum energy of a beta particle is a characteristic 

signature for different radioisotopes.   

In this experiment, you will find the range of beta particles by measuring their 

attenuation with absorbers and extrapolating the absorption curve.  The range R will 

then be substituted into the formula 

212.084.1 += REβ                                                     (1) 

where R is in g/cm2.  (Note that the units for R are not the same as the absorber 

thicknesses.  You must convert at the end.)  See Figure 1 for an example of an energy 

curve for beta particles.  
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Figure 1: Typical plot of beta particle energy curve.   
  

The spectrum is not linear and “tails” off at high energy, which means that there 

are very few beta particles (This effect is seen with the phenomenon of range 

straggling, which was observed in the absorption curve in the previous experiment.)  

The reason is that most of the beta particles cannot penetrate the absorber and most of 

the counts are background counts.  Thus, one must assume linearity and extrapolate 

the line to the x-axis.  There are two options to finding this x-intercept.  The first is to find 

an equation for the best-fit line of the data in slope-intercept form, y = mx + b.  Then set 

y = 0 and solve for the x value, since the x-intercept is the point on the line where the y 

– coordinate is zero.  The second method is to take a copy of the plot and use a rule to 

continue the linear part of the data through the x-axis and finding that point.   

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 2. 

• Radioactive Source (beta sources – we recommend Sr-90 or Tl-204) – green 

source shown in Figure 2. 
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Figure 2: Setup for ST350 with sources and absorber kit. 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 
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3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to three and set Preset Time to 60. 

5. First do a run without any absorber and with a radioactive source.  Place the source 

in the second shelf and click the green diamond to begin taking data.  No 

background reading is taken because 204Tl and 90Sr are relatively strong beta 

sources (high count rates) and the background will be negligible (20-40 cpm).  

Remember that there are three one-minute runs being taken. 

6. Next, place the first absorber in the top shelf, directly above the source, and begin 

taking data (click on the green diamond).   

7. Change your absorber each time for as many absorbers as the instructor allocates 

to you.  You should see the data accumulating in the Data window.  After all the 

absorbers have been used, save the data onto disk or record in a data table.   

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2 enter Dead Time = and then in cell F2 enter the value for your GM tube’s 

resolving time.   

3. In cell G9 enter Corrected and in cell G10 enter G10.  Next, in cell G13, enter the 

formula =C12/(1-(C12*$F$2)) to correct for your data for resolving time.  Copy this 

formula down for all the cells that should contain data. 

4. In cell H9 enter Thickness and in cell H10 enter (mg/cm2).  Then, in column H 

beginning with cell 12, enter the thickness values you used taking data. 

5. In cell I9 enter Log of and in cell I10 enter Activity. Next, in cell I13, enter the formula 

=LOG(G13) to calculate the logarithm (base 10) of your data.  Copy this formula 

down for all the cells that should contain data.  Taking the logarithm of the data 

substitutes for plotting your data on semi-log paper.   
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6. Next, make a graph of Log of Activity vs. Thickness.  Start with the Chart Wizard 

either by choosing Chart from the Insert Menu or pressing its icon on the top toolbar. 

7. Select the XY (Scatter) Plot from Plot Types and click on Next. 

8. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

Log of Activity and Thickness columns of data.  When you have done this, hit the 

Enter key.  The other way to do this is to choose the Series tab.  Click remove to 

eliminate two of the three series listed as default values.  Now using the cursor 

button to the right of the X-Values window, highlight the thickness values in the H 

column.  Using the cursor button to the right of the Y-Values window, highlight the 

Log of Activity values in the I column.  When either one of these methods is 

completed, click on Next. 

9. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

10. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

11. Position your cursor directly over one of the data points on your graph.  Then click 

the right button on the mouse and watch a small menu appear.  Choose the Add 

Trendline option.  You may click OK here or if you want more information choose the 

Options Tab.  There you may click in the boxes for Display Equation on Chart (for 

the equation of the line in slope-intercept form to appear on the graph) or on Display 

R-squared value on chart (this gives a decimal representation of the percentage 

completely linear the data is).   

12. In cell A34, copy the equation shown for the best-fit line in your graph.  Then, set y = 

0 and solve for x.  This breaks down to dividing the negative of the y-intercept by the 

value for the slope (should be negative).  Take the value for x and divide it by 1000, 

because your answer was in mg/cm2.  But to use the equation given earlier for 
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maximum energy, you need x in units of g/cm2.  This is your value of the range R of 

a beta particle emitted from your source. 

13. Then plug your value for R into 212.084.1 += RE and get a value for E.  Place this 

value in cell B36.  In cell A36, enter E =.   

14. In cell A38 enter True Value for E =.  Then in cell B38, enter the literature value for 

your source.  (Sr-90 has E = 0.546 MeV and Tl-204 has E = 0.7634 MeV.) 

15. In cell A40 enter Percent Error =.  In cell B40, enter the formula =((ABS(B36-

B38))/B38)*100.  This formula represents the formula 

100% ×
−

=
true

measuredtrue
error .          (2) 

 

Conclusions: 

 You should have found the value for the maximum energy of a beat particle from 

your source and the percent error of this result when compared to the literature value.  

However, this percent error is not a good way to determine experimental error.  As 

discussed in a previous lab, the best way to determine error is to use the standard 

deviation.  So, calculate σ for your value of E – you will have to use propagation of 

errors. (OPTIONAL)   

 

Post-Lab Questions: 

1. Does your data follow Excel’s ® best fit line?  If not, why?   

Answer: The beta energy plot tails off at high thickness, because the beta 

particles are almost completely absorbed but background is still being 

absorbed. 

2. Why does the data fluctuate so much at high absorber values, especially 

those above 1400 mg/cm2?  How can this be handled in the data analysis 

stage? 

Answer: Above 1400 mg/cm2, there is only background readings which 

fluctuate naturally due to the statistical nature of background radiation.  

You can ignore these higher values in the data analysis, since they 

contain no relevant information.  
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3. Is your result for E accurate?  Is it still a good result even if it is not exactly the 

same as the literature value?   

Answer:  Accuracy of student work depends on their final results.  They 

should get a reasonably close results if the experiment is performed 

correctly. 
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  Data Sheet for Beta Energy Lab 
      

Tube #:   Run Duration:   

Dead Time:   (Time)   

      

Counts Corr. Counts Thickness ln (Counts)   

      

      

      

      

      

      

      

      

      

      

      

Equation for line:      y=     

For y=0, x=  mg/cm^2   

      

Conversion x=  g/cm^2 (This is the range)  

Use E = 
1.84*R+0.212 

    

      
 E=  MeV   

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #12: Absorption of Gamma Rays 

Objective:  

 The student will investigate the attenuation of radiation via the absorption of 

gamma rays. 

 

Pre-lab Questions: 

1. How do gamma rays interact with matter (hint: there are three)?   

Answer:  The three mechanisms are Photoelectric Effect, Compton Scattering, 

and Pair Production.  See the section on Interactions with Matter for more 

details. 

2. Where are gamma rays on the electromagnetic spectrum? 

Answer:  Gamma rays on one extreme of the EM spectrum where energy is 

the highest, frequency is the highest, and wavelength is the shortest.   

3. How do you calculate mass thickness (g/cm2) from other quantities? 

Answer:  Use the density of the material and the linear thickness.  Suppose 

the density is in g/cm3 and linear thickness is in cm, then the absorber 

thickness is given by 
23 cm

g
cm

cm

g
=• . 

 

Introduction: 

 Gamma radiation unlike alpha and beta radiation, consists of electromagnetic 

waves.  Gamma rays are emitted as photons, or little “packages” of energy called 

quanta, which travel at the speed of light (c = 3.0 x 108 m/s1).  What differentiates 

gamma rays, x-rays, visible light, and radio waves is their position in the 

electromagnetic spectrum (see Figure 1).  What actually happens is that some of these 

“zones” actually overlap, especially between x-rays and gamma rays.  While this is not 

shown in explicitly in Figure 1, you can see that the x-rays and gamma rays do reside 

next to one another on the spectrum.   

                                                             
1 A unit conversion shows that 3.0 x 108 m/s = 30 cm/ns.  That means in one nanosecond light travels 30 cm or in 
one second light travels 30 billion centimeters. 
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Figure 1: The electromagnetic spectrum 

 One significant difference between x-rays and gamma rays is their origin.  X-rays 

are produced in the electron shells, while gamma rays are produced in the nucleus.  X-

rays are created when electrons undergo a deceleration or jump to lower energy levels.  

Gamma rays are created by energy transitions in the nucleus.  In this experiment, we 

are mostly concerned with gamma rays, because any x-rays present will be shielded by 

air and matter acting as absorbers. 

 When a beam of gamma rays impinges on a sheet of absorbing material, some 

of the radiation will be absorbed or scattered2.  As the thickness of the absorber is 

increased, the fraction of the radiation passing through will decrease.  When exactly half 

                                                             
2 Gamma rays interact with matter in three ways: (1) photoelectric effect (ionization), (2) Compton effect, and (3) 
pair production (e+e-).  Your instructor can explain more. 
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the radiation passes through the absorber (and the other half is absorbed or scattered), 

the thickness of the absorber is called the half thickness, X1/2.  

 This thickness, X, is not normally how we perceive thickness.  We normally 

consider it to be a distance possibly in cm.  Here, thickness is short for mass thickness.  

Why?  Because the thickness of different materials represents different amounts of 

matter (atoms).  But a mass thickness is used to represent how much matter is being 

passed through (regardless of whether it is air, aluminum, or lead).  To calculate mass 

thickness you simply multiply the density of the material (g/cm3) times its length, or 

normal thickness, (cm) to get the mass thickness (g/cm2).  The absorbers you will use 

for this experiment have their thickness listed as mass thickness because that quantity 

can be used to compare the plastic to lead absorbers.    

 Since the intensity of radiation is reduced by 50% by passing through one X1/2, it 

will be reduced by another 50%, or only to 25% of the original intensity, in passing 

through a second X1/2 of absorber.  A linear relationship is obtained if the data are 

plotted using semilog paper or if the logarithm of the activity is plotted as a function of 

the absorber thickness. 

 The attenuation (or absorption and scattering) of gamma rays is exponential in 

nature which is shown by the equation: 

X
oeII µ−=                       (1) 

where I is the intensity of the beam after passing through X amount of aborbing 

material, Io is the original intensity, µ is the mass attenuation coefficient, and X is the 

mass thickness.  Since the intensity of the gamma rays is cut in half after passing 

through X1/2, we can rewrite Equation 1 as  

2/1

2

1 X
oo eII µ−= .                  (2)  

The Io terms cancel giving 

     2/1

2

1 Xe µ−= ,                   (3) 

which can again be rewritten by taking the natural logarithm of both sides 

2/12
1

ln Xµ−=





 .                  (4) 
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Using the rules of exponents, we know that ln(1/2) = -ln(2), so that gives 

2/1)2ln( Xµ= .                   (5) 

One final rearrangement gives us a value of the mass attenuation coefficient 

2/12/1

693.0)2ln(
XX

==µ .                  (6) 

During your data analysis, you will find a value for X1/2, and thus one for µ. 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 2. 

Figure 2: Setup for ST350 with sources and absorber kit. 
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• Radioactive Source (gamma ray emitter – any of the sources pictured in 

Figure 3)  [NOTE to instructor: have students repeat the experiment with 

different sources to observe any differences.] 

Figure 3: Kit of eight different gamma sources. 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen.  
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3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  

4. From the Preset menu, set Runs to zero and set Preset Time to 60. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, place the radioactive source in the second shelf from the top and begin taking 

data (click on the green diamond).   

7. Place an absorber piece in the top shelf and take another run of data clicking on the 

green diamond to begin. 

8. Repeat this a minimum of 5 more times with absorbers of varying thickness.  

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2, enter “Dead Time =” and in cell F2 enter the dead time determined for 

your GM tube.   

3. In cell G9, enter Thickness and in cell G10 enter mg/cm2.  Then starting in cell G13, 

enter the thickness for the absorbers used.  For cell G13, it should be zero (no 

absorber used).  In column F, under Notes, it may be convenient to enter the letters 

associated with the absorbers you used.  

4. In cell H9 enter Dead Corr. and in cell H10 enter Counts.  Then starting in cell H13, 

enter the formula =C13/(1-(C13*$F$2)) to correct for the dead time of the GM 

counter.  Copy this formula down the column for all the data you collected. 

5. In cell I9 enter Bkgd. Corr. and in cell I10 enter Counts.  Then starting in cell I13, 

enter the formula =H13-$C$12 to correct for the background of the GM counter. 

Copy this formula down for all the data you have. 

6. Next, make a graph of Corrected Counts per Minute vs. Thickness.  Start with the 

Chart Wizard either by choosing Chart from the Insert Menu or pressing its icon on 

the top toolbar. 
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7. Select the XY (Scatter) Plot from Plot Types and click on Next. 

8. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the second Bkgd. Corr. Counts (column I) and Thickness (column G) 

columns of data.  (Use the Ctrl key to highlight more than one column of data.)  

When you have done this, hit the Enter key.  The other way to do this is to choose 

the Series tab.  Click remove to eliminate two of the three series listed as default 

values.  Now using the cursor button to the right of the X-Values window, highlight 

the Thickness values in the G column.  Using the cursor button to the right of the Y-

Values window, highlight the Bkgd Corr Counts values in the I column.  When either 

one of these methods is completed, click on Next. 

9. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

10. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

11. Right click on the y-axis of the graph and choose the Format Axis option.  Then 

choose the Scale Tab, and check the Logarithmic Scale option towards the bottom. 

12. Right click on one of the data points and choose the Add Trendline option.  Make 

sure that the box labeled Linear is highlighted.  Then, click on the Options Tab and 

choose one of the bottom options: Display equation on chart.  This is will give you 

the equation of the best fit line through your data. 

 

Conclusions: 

 From your best fit line equation, find the values for X1/2 and µ.  Make sure your 

answers are in the appropriate units (involving grams and centimeters). 

 

Post-Lab Questions: 

1. Is your data linear?  If not, why? 
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Answer: It should be linear on the plot either on semi-log paper or on a 

normal graph where logarithms are plotted on the y-axis.  Check sources 

of error for validity. 

2. Looking at your data and equating intensity and counts per minute, does your 

result for X1/2 a correct approximation?  (Does your result match the data?) 

Answer:  Student should show here that the intensity reaches half of its 

original value between two absorber thicknesses that straddle the value 

obtained from the graph. 

3. Can we be completely shielded from gamma rays?  If not, then why bother? 

Answer: Not with this equipment, because it requires a lot more lead that 

we have.  We bother because half of the intensity is better than all of it.  

We can attenuate it fairly well to protect us, and there are places that can 

implement the proper shielding. 

4. Comparing your range for alpha particles, the absorption of beta particles, 

and now the results for gamma rays, why are they different? 

Answer: They are different because of what they are.  The more massive 

particle is sopped by the least amount of matter, while the energy ray can 

pass through all the absorbers we have.  While this is a size issue, it also 

contributes to how they interact with matter. 
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  Data Sheet for Gamma Absorption Lab 
     

Tube #:   Run Duration:  

Dead Time:   (Time)  

     

Counts Corr. Counts Thickness ln (Counts)  

     

     

     

     

     

     

     

     

     

     

     

Equation for line:              
y= 

   

 µ=  mg/cm^2  

OR µ=  g/cm^2  

     

Calculate  x_1/2 = ln(2)/µ   
     

 x_1/2 =  g/cm^2  
 
 

Name:      Lab Session:     
Date:       Partner:      

Don’t forget to hand in a graph of the data with this table. 
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Lab #13: Half-Life of Ba-137m 

Objective:  

 The student will measure the half-life of metastable barium-137. 

 

Pre-lab Questions: 

1. Explain how you will obtain Ba-137m from the isotope generator. 

Answer:  The eluting solution strips away Ba-137 from Cs-137 and suspends it in 

liquid for usage.  The Ba-137 is present because it is a decay product of Cs-137.   

2. Draw the decay diagram for the process you describe in #1. 

Answer:  

 

3. If a Sr-90 source has a count rate of 7020 cpm today.  When will it have a count rate 

of 1404 cpm?  The half-life of Sr-90 is 28.6 yrs.  What about Po-210 with the same 

count rates (half-life for Po-210 is 138 days)? 

Answer:  The Sr-90 will have the 1404 cpm rate 66.4 years from today.  We start 

with the equation t
oeNN λ−= and rearrange it to become 

λ









−

= oN

N

t

ln

.  We saw 

above that 
2/1

)2ln(

t
=λ .  Making this substitution gives us 



























−=
)2ln(

ln

2/1
oN

N

tt .  



103 

 

Plugging in our numbers give us the 66.4 years.  For Po-210, we use the same 

equations, but the answer is 320 days.  

4. If a Tl-204 source has 1.34 x 1021 atoms today.  When will it have 1.675 x 1018 

atoms?  The half-life for Tl-204 is 3.78 years. 

Answer: The method is exactly the same as for question #3, because the 

equations for activity and number of particles are the same.  So our answer is 

36.5 years. 

 

Introduction: 

 The decay of radioactive atoms occurs at a constant rate.  There is no way to 

slow it down by maybe refrigeration or to accelerate the process with heat.  The rate of 

decay is also a constant fixed rate regardless of the amount of radioactive atoms 

present.  That is because there are only two choices for each atom, decay or don’t 

decay.  Thus, the amount of radioactive atoms we have on hand at any time is 

undergoing a consistent, continuous change. 

 The change in the number of radioactive atoms is a very orderly process.  If we 

know the number of atoms present and their decay constant (probability of decay per 

unit time), then we can calculate how many atoms will remain at any future time.  This 

can be written as the equation 

tNNtN ∆−= λ)( ,           (1) 

where N(t) is the number of atoms that will be present at time t, N is the number of 

atoms present currently, λ is the decay constant, and ∆t is the elapsed time.  If the 

number of radioactive atoms remaining is plotted against time, curves like those in 

Figure 1 can be obtained.  The decay constant can be obtained from the slope of these 

curves (discussed more below). 

Figure 1: Exponential and Linear decay curves shown respectively 
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 A more common way of expressing the decay of radioactive atoms is the half-life.  

The half-life of a radioactive isotope is the time required for the disintegration of one-half 

of the atoms in the original sample.  In the graphs in Figure 1, 1000 atoms were present 

at t = 0.  At the end of one half-life, 500 atoms were present.  At the end of two half-

lives, 250 atoms were present, one-quarter of the original sample.  This continues on 

and on, and example of what happens in the first nine half-lives is shown in Table 1. 

# of Half-lives Activity Percent Fraction 
0 1000 100% 1 
1 500 50%    1/2   
2 250 25%    1/4   
3 125 12.5%    1/8   
4 62.5 6.25%    1/16  
5 31.25 3.125%    1/32  
6 15.625 1.563%    1/64  
7 7.8125 0.781%    1/128 
8 3.90625 0.391%    1/256 
9 1.953125 0.195%    1/512 

 

Table 1: Table of Example of Radioactive Decay 

 Since the observed activity of a sample as detected by a Geiger counter is 

proportional to the number of radioactive atoms, it is not necessary to know exactly how 

many atoms are present to determine either the half-life or the decay constant.  Any 

quantity of sample providing a suitable activity may be used.  The derivations presented 

below use the number of radioactive atoms but could very easily be substituted with 

activity, since activity
time

atomsof

time

countsof ##
== .  (Each count of a GM tube represents 

one atom decaying and releasing one particle or ray of radiation.) 

 Looking back at Equation (1) in a slightly rearranged form 

    tNNtN ∆−=− λ)( .                     (2) 

But N(t)-N is just the change in the number of radioactive isotopes of the original type 

present, so we can define  

tNNtNN ∆−=−=∆ λ)( .                              (3) 

Dividing both sides of the equation gives 
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N
t

N
λ−=

∆
∆

,                      (4) 

but in calculus1 we write changes, especially small, or infinitesimal, changes as 

N
dt

dN
λ−= .                      (5) 

This is a separable differential equation that becomes  

dt
N

dN
λ−= ,                      (6) 

which can be solved by integrating both sides.  When we do this we impose limits for 

the integrals2, and pull λ out of the integral because it is a constant.  The limits for dN’/N’ 

are from No to N, which is from the initial number of particles (No) to the new amount of 

particles (N).  The limits for dt are from the beginning, where t=0, to the end  

∫∫ ′−=
tN

N
td

N

dN
o 0'

'

λ .                  (7) 

The solution to this equation is 

tNN o λ−=− )ln()ln( .                 (8) 

Solving for ln(N), gives 

tNN o λ−= )ln()ln( .                     (9) 

Thus, if we plot the natural log of the number of atoms (or activity) versus time, we will 

get a straight line with slope = -λ and y-intercept = ln(No).  This would allow us to find 

the decay constant.  Why?   

 We will need the decay constant in the next step, which is to find the half-life of 

the radioactive isotope we are studying.  Starting from Equation (8) and applying a 

simple logarithmic identity, we get 

t
N

N

o

λ−=







ln .                   (10) 

If we are considering the half-life, then N is one-half of No (reduced ratio) and t is t1/2.  

This changes our equation to be 

                                                             
1 If you have not had Calculus yet, do not worry about the details of the derivation.  Concentrate on the 
second part where natural logarithms are used.  You should have this knowledge to perform the lab. 
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2/12
1

ln tλ−=





 .                   (11) 

Applying the reverse of our previous logarithmic identity, we get 

2/1)2ln()1ln( tλ−=− .                   (12) 

The ln(1) = 0, so now we have 

2/1)2ln( tλ−=− .                   (13) 

Finally, we can solve for the half-time 

λ
)2ln(

2/1 =t .                    (14) 

 

Equipment: 

• Set-up for ST-350 Counter with GM Tube and stand  (Counter box, power 

supply – transformer, GM Tube, shelf stand, serial cable, and a source holder 

for the stand) – shown in Figure 2. 

Figure 2: Setup for ST350 with sources and absorber kit. 

                                                                                                                                                                                                    
2 We have to change dN/N to dN'/N' because one of the limits is N, and we are not allowed to have a limit 
that is the same as the differential (dN part).  For the same reason, we change dt to dt’.  This is a basic 
substitution. 
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• Radioactive Source (Cs/Ba-137m Isotope Generator – shown in Figure 3)  

Figure 3: Isotope Generator to make Ba-137m from Cs-137 

 

Procedure: 

1. Plug in the transformer/power supply into any normal electricity outlet and into the 

back of the ST-350 box.  Next, remove the red endcap from the GM tube VERY 

CAREFULLY.  Place the GM tube into the top of the shelf stand with the window 

down and BNC connector up.  Next, attach the BNC cable to the GM tube and ST-

350.  Finally, attach the serial cable to the ST-350 and a serial port on the back of 

your PC (if you are using one). 

2. Turn the power switch on the back of the ST-350 to the ON position, and turn the 

DISPLAY FUNCTION knob on the front face to the remote setting.  Then open the 

computer interface by pressing the START key on the PC.  Then look under 

Programs -> SpecTech options for the ST350 option.  You should then see the blue 

control panel appear on your screen. 

3. Under the Setup Menu, choose HV Setting.  Set the Voltage of the GM Tube to its 

optimal operating voltage (found in the Plateau Lab).  This voltage should be around 

900 Volts.  Also, make sure that the Step voltage is set to 0 and Step Voltage 

Enable is set to Off.  
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4. From the Preset menu, set Runs to zero and set Preset Time to 30. 

5. First do a run without a radioactive source.  This will determine your background 

level.  Click the green diamond to begin taking data. 

6. Next, from the Preset menu, se the Runs to 31.  (This will take 30 more runs so the 

total number of runs is 31.) 

7. From the isotope generator, obtain 10-12 drops of Ba-137m.  Place the radioactive 

source in the second shelf from the top and begin taking data (click on the green 

diamond).   

8. Record the data to a file on disk or into a data table. 

9. You may wish to do a second trial is time allows.   

 

Data Analysis: 

1. Open Microsoft Excel ® and choose Open in the File Menu.  Open your data file.  

Go through the Text Import Wizard by choosing Next, Next, and Finish. 

2. In cell E2, enter “Dead Time =” and in cell F2 enter the dead time determined for 

your GM tube.   

3. In cell G9 enter Dead Corr. and in cell G10 enter Counts.  In cell G13, enter the 

formula =C13/(1-(C13*$F$2)).  Copy this down for the cells that have counts in 

column C.  This corrects the counts for resolving (dead) time but not the background 

counts, because any correction for them would be less than one count. 

4. In cell H9 enter Bkgd Corr and in cell H10 enter Counts.  In cell H13, enter the 

formula =G13-$C$12.  Copy this down for the cells that have counts in column G.  

This corrects for background. 

5. In cell I9 enter Natural Log and in cell I10 enter of Activity.  In cell I13 and below, 

enter the formula =LN(H13), and copy this down for the cells that have counts in 

column H.  

6. In cell J10 enter Time (s).  In cell J13, enter 30.  In cell J14, enter the formula 

=J13+30, and copy this down for the cells that have entries in column I.  

7. Next, make a graph of Natural Log (Ln) of Activity vs. Time.  Start with the Chart 

Wizard either by choosing Chart from the Insert Menu or pressing its icon on the top 

toolbar. 
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8. Select the XY (Scatter) Plot from Plot Types and click on Next. 

9. For Chart Source Data, there are two ways to change the default selection by Excel 

to become the correct data points.  For the Data Range window when the Data 

Range Tab is selected, click on the cursor picture on the far right end of the window.  

You will then go to the spreadsheet.  While holding down the Ctrl key, highlight the 

data under the Ln of Activity (column I) and Time columns of data (column J).  [Use 

the Ctrl key to highlight more than one column of data.]  When you have done this, 

hit the Enter key.  The other way to do this is to choose the Series tab.  Click remove 

to eliminate two of the three series listed as default values.  Now using the cursor 

button to the right of the X-Values window, highlight the Time values in the J column.  

Using the cursor button to the right of the Y-Values window, highlight the Ln of 

Activity values in the I column.  When either one of these methods is completed, 

click on Next. 

10. Fill in the Chart Title, Value (X) Axis, and Value (Y) Axis windows with appropriate 

names and units (if applicable) for those items.  When you are done, click Next 

11. Choose whether you want to view your graph as a separate worksheet as your data, 

or you wish to see a smaller version of the graph with the data.  Click Finish when 

you have chosen one or the other. 

12. Adjust the size of the graph for your preference (or the instructor’s).  You may also 

wish to adjust the scales on one or more of the axes.  Again, this is a preference 

issue. 

13. Right click on one of the data points and from the menu that appears, choose Add 

Trendline.  Make sure that the Linear option is chosen (should be darkened).  Then 

click on the Options tab and check the boxes for Display equation on chart and 

Display R-squared value on chart.  This will make the equation of the best fit line 

appear as well as a number that represents the percent of linearity of the data.   

14. Make another graph, except this time use the Bkgd Corr. Counts vs. Time.  From 

this graph, you will be able to see the true exponential nature of the decay and also 

be able to estimate approximate half-lives.   
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15. Now, you will perform a linear regression over three different sets of numbers.  A 

linear regression finds the slope and y-intercept for the best-fit line through the data 

chosen.   

16. In the Tools menu, choose Data Analysis (ask your teacher if this option does not 

appear).  Then a small window will appear.  Scroll down and choose the Regression 

option.  Now, a larger will appear.  You will have to choose X-Values, Y-Values, and 

an Output Range.   

17. For the first linear regression, choose the first 15 data points under Natural Log of 

Activity (column I) for the Y-Values by clicking on the box at the end of the input 

window, outlining these numbers in column I, and then pressing the Enter key.  (You 

can either count 15 data points, or a small yellow box will appear and you enclose 

numbers in the column until it reads 15R x 1C which means 15 rows in one column.)  

Now, for the X-Values, choose the first 15 Time values in column J.  Make sure the 

Output Range is chosen.  Then, either enter $M$1 in the input window or click on the 

box and choose the M1 square.  Click on OK and the results will appear on the 

spreadsheet.   

18. For the second linear regression, choose the data points 16-30 and choose the 

output range to be M19.  (We are squeezing them together because if you print in 

landscape, these two will be on the same page.)   

19. For the third linear regression, choose all 30 data points and choose the output 

range to be M37.  Does the slope for this linear regression match the slope from the 

first graph?    

20. To perform your final calculations, you will need the slopes from these linear 

regressions and the error for the slope. The slope is the Coefficient of the X-Variable 

(Why?) and is found in cells N18, N36, and N54.  The error is the Standard Error of 

the X-Variable and is found in cells O18, O36, and O54.  
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Conclusions: 

 Fill in the following table: 

 

Data Points λ t1/2 Error # of σ’s 

First Half     

Second Half     

All     

 

The variable λ is the decay coefficient.  If you assumed you plotted Equation (9), then 

the slope from the linear regression is the negative of λ   

)(slope−=λ .          (15)  

From Equation (14), you can calculate the half-life: 

λλ
693.0)2ln(

2/1 ≈=t .         (16) 

If you perform the proper error propagation, then you will end up with a final equation of 

λ
σσ

λ=
2/1

2/1

t
t .          (17) 

Rearranging this equation to calculate 
2/1t

σ gives 

λ
σ

σ λ 2/1
2/1

t
t

⋅
= .         (18) 

Now, to find the number of σ’s that your result is away from the true value of t1/2 = 153 s, 

we use the following equation 

2/1

'#
t

truemeasured
sof

σ
σ

−
= .         (19) 

What you measure is the distance from your result to the true value and then see how 

many standard deviations that is.  The rule of thumb is that the result should be no more 

than 2 σ’s away from the true value to be statistically good. 
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Post-Lab Questions: 

1. Write your result with the error, i.e. 153 s ± 1 s.  Is this result (statistically) 

good?  (Recall that any value judgements must be justified.) 

Answer:  The value for their half-life should be within 2 standard deviations 

of the known value for the half-life of Ba-137m, 153 s.   

2. Which of the three results is better?  Why? 

Answer: The results should be best for the first set of measurements, 

because the amount of Ba-137m is still high so the count rate is higher.  

The less Ba-137m present results in a lower count rate and more error 

that can occur.  This is due to the fact the statistical fluctuations carry 

more meaning in lower count rates. 

3. How can the situation in #2 be resolved so that a linear regression over all the 

data gives a more valid result?  (How can you combine the halves of the 

data?) 

Answer: There could be a weighting system introduced that weights the 

earlier values more and the later values less.  Another possibility is to fit 

the two parts separately (this is a common method is particle physics).  

Any others are fine as long as they are practical and valid. 
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  Data Sheet for Half-Life Lab 
      

Tube #:   Run Duration:   

Dead Time:   (Time)   

      

Counts Corr. Counts ln(Counts) Time   

    (Background Count)  

   30   

   60   

   90   

   120   

   150   

   180   

   210   

   240   

   270   

   300   

   330   

   360   

   390   

   420   

   450   

Name:      Lab Session:     
Date:       Partner:      
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  Data Sheet for Half-Life Lab (Cont’d) 

Counts Corr. Counts ln(Counts) Time   

   480   

   510   

   540   

   570   

   600   

   630   

   660   

   690   

   720   

      

      

Data λλ   t1/2 Error # of σσ 's  

First Half      

Second Half      

Whole       

 
 
 
 

 

Don’t forget to hand in a graph of the data with this table. 
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Appendix A – SI Units 
 
 The standard units of measure used in physics are the MKS (Meter, Kilogram, 
Second) version of the International System (SI) of Units.  They are commonly referred 
to as the metric units.  The latest version of the standards can be found in the following 
three resources: 
• “Preferred Metric Units for General Use by the Federal Government,” (Federal 

Standard 376B), January 27, 1993, General Services Administration. 
• “Guide for the Use of International System of Units (SI),” (NIST Special Publication 

811) (obtainable at the NIST website -  http://www.nist.gov) 
• “The International System of Units (SI),” (NIST Special Publication 330) (obtainable 

at the NIST website – http://www.nist.gov) 
 
 

Below, you will find the proper SI units – base and derived – that we will use.  Also, 
there is a table showing the latest prefixes for SI Units. 
 
 
 

Physical Quantity Name of Unit Symbol 

 Base Units  

Length meter m 
Mass kilogram kg 
Time second t 

Electric current ampere A 
 Derived Units  

Force newton N 
Energy joule J 

electric potential volt V 

electric resistance ohm Ω 
electric capacitance farad F 

activity (radioactive source) becquerel Bq 
   

Table 1: Proper SI units that may be used in the lab manual. 
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           Mulitplication Factor     Prefix Name Prefix Symbol 
1 000 000 000 000 000 000 000 000 = 1024  yotta   Y 
       1 000 000 000 000 000 000 000 = 1021    zetta   Z 
              1 000 000 000 000 000 000 = 1018    exa   E 
           1 000 000 000 000 000 = 1015   peta   P 
        1 000 000 000 000 = 1012   tera   T 
               1 000 000 000 = 109  giga   G 
            1 000 000 = 106    mega   M 
                  1 000 = 103   kilo   k 
            100 = 102   hecto   h 
              10 = 101  deca   da 
             0.1 = 10-1  deci   d 
           0.01 = 10-2   centi   c 
         0.001 = 10-3  milli   m 
            0.000 001 = 10-6    micro   µ 
               0.000 000 001 = 10-9  nano   n 
        0.000 000 000 001 = 10-12  pico   p 

          0.000 000 000 000 001 = 10-15  femto   f 
   0.000 000 000 000 000 001 = 10-18  atto   a 

       0.000 000 000 000 000 000 001 = 10-21  zepto   z 
0.000 000 000 000 000 000 000 001 = 10-24  yocto   y 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



117 

 

Appendix B – Common Radioactive Sources 
 
 Below is a list of commonly used radioactive sources.  All of these sources are 
available from Spectrum Techniques, Inc.  The standard radioisotopes sold by 
Spectrum techniques, Inc. are exempt from NRC licensing and require no special 
handling, storage or disposal. 
 

 
 
 

 Isotope Generator 
 

The Cs-137/Ba-137m Isotope Generator provides a convenient means of 
producing a short half-life isotope for demonstrating radioactive decay 
experiments. This improved design is based on the original Union Carbide patent 
and can produce up to 1000 samples of the Ba-137 isotope with a half-life of 2.6 
minutes using a simple eluting solution of 0.9% NaCl. The kit is supplied 
complete with the Cs-137/Ba-137m generator, 250 ml of eluting solution, a 
syringe for the elution and a storage case. 
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Appendix C – Statistics 
 

Statistics play a very important part of physics, especially nuclear physics, 

because we are dealing with atoms that number on the order of Avagrado’s number.  It 

is impossible to deal with every single atom individually, so we rely on statistics to give 

us a prediction of behavior.   

 Statistics uses two main quantities in predicting behavior, the mean and the 

standard deviation.  The mean is the average, what most of the particles are doing.  The 

standard deviation tells us how many particles are also doing almost the same thing as 

the mean.  The previous experience that students usually have with mean and standard 

deviation is from mathematics class (unless a statistics class has been taken).  From 

this experience, they know that mean can formulated by 

∑
=

=
N

i

i

N

x
x

0

,                       (1) 

where x is the mean of a set of measurements ix (i = 1, 2, 3, …, N), and N is the 

number of measurements taken. 

Most students can recall how to calculate the standard deviation  

( )
1

0

2

−

−
=

∑
=

N

xx
N

i
i

σ .                  (2)  

What this equation does is measure the variance without regard to direction above or 

below the mean (that is why you square and then square root – it is equivalent to 

absolute value which just measures distance).  These equations hold for most 

everything the students have dealt with up to this point in school.  The reason is that 

most measurements follow a Gaussian distribution (symmetric about a mean).   

 Counting in nuclear physics is not symmetric about a mean.  There is usually 

some count rate that is pretty small because probability of decay is pretty small.  Then 

you also get high count rates.  (Look back at the data from the statistics experiments 

you performed this year.)  When the data collects to a small number with a bit of a tail, 

this is no longer a Gaussian distribution.  The standard three statistical distributions will 



119 

 

be discussed below to assist the student learning more in detail about the statistics of 

counting in nuclear physics.   There are many more statistical distributions used for 

various reasons but they will not be discussed here.  (An example is the Landau 

distribution used in describing the energy loss of a charged particle in matter, which is 

different because it has an infinitely long tail to it.) 

 The first distribution is the Binomial distribution.  This distribution is used when 

you have two possible outcomes, the probability of getting one of those outcomes (and 

thus the other) is a constant number independent of the number of trials, and the 

selection of either outcome does not affect that outcome again in later trials.  A good 

example of this is flipping a coin.   

To look at an example, we have an experiment where there are only two 

outcomes A and B.  In a binomial distribution, we deal with p, the probability that you will 

get one of the outcomes (A), and q, the probability that the other outcome occurs (B).  

Sometimes, instead of q, statistics books use 1-p, which is how q is calculated.  Then, 

the binomial distribution gives the probability, P(n), that n out of N objects are A is given 

by 

( ) ( ) ( ) nNnnNn pp
nnN

N
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nnN
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)( .        (3) 

Now for this distribution the mean, m, is given by  

pNm =                   (4) 

and the standard deviation is calculated with any of the following 

)1( pNpNpqmq −===σ .                 (5) 

 In order to study radioactive decays, we need a more useful distribution.  We 

need one for a very large number of counts and one that can handle a very small 

probability of success (large N and small p).  It just happens that the Poisson 

distribution is the special case of the binomial distribution given those two conditions.   

The Poisson distribution gives the probability, P(n), that n out of N objects are A as 

m
n

e
n

m
nP −=

!
)( ,                  (6) 

where m is the mean of the distribution (m = Np).  The nicest feature of the Poisson 

distribution is the ease to calculate standard deviation.  The formula is  
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m=σ .                   (7) 

But for individual measurements, we take the standard deviation to be the square root 

of the number of counts, here N,  

N=σ .                   (8) 

So if you have a count rate of 10,000 cpm, then the standard deviation is ±100 cpm.   

 You may have noticed that for large values of m, the Poisson distribution 

becomes hard to use.  So we use a special case of the Poisson distribution for m>20 

(the accepted rule of thumb), or a different special case of the Binomial distribution that 

has large counts, low probability, and a large mean.  This new distribution is called the 

Normal or Gaussian distribution.  This is the distribution that most students are familiar 

with, its common name is the bell curve.  Another added feature of this distribution is 

that it can handle continuous variables (like most of those in our experiments), unlike 

the Poisson and Binomial distributions which can only handle discrete variables*.  The 

Gaussian distribution is given by  

( )
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This equation gives us the mean and standard deviation equations that we are 

accustomed to in Equations (1) and (2).  

 More details about statistical distributions must researched in other books.  There 

is a huge amount of resources out there, statistical books and methods in experimental 

physics books abound.  There are some of the latter books listed below if you wish to do 

more research.  These should be available at most university libraries, or through 

interlibrary loan services. 

1. P.R. Bevington, D.K. Robinson, Data Reduction and Error Analysis for the Physical 

Sciences,  (McGraw-Hill, 1992). 

2. G. Knoll, Radiation Detection and Measurement, (John Wiley & Sons, 1989)**. 

3. N. Tsoulfanidis, Measurement and Detection of Radiation, (McGraw-Hill, 1995). 

                                                             
* The number of counts is a discrete, there is no such thing as a fraction of a count (there is nothing between 1 and 
2).  Length is a continuous variable, between 1 and 2 is 1.5.  Between 1 and 1.5 is 1.25 and so on.  
** There is a newer edition this one.  This edition is the one the author owns. 



121 

 

4. W.R. Leo, Techniques for Nuclear and Particle Physics Experiments, (Springer-

Verlag, 1994) 

 
 

Linear Regression 

 When Excel® or a graphing calculator performs a linear regression, it makes two 

calculations to determine the slope and y-intercept of the best-fit line for the data.  How 

does it do it? Linear regressions are carried out using the method of least squares.  This 

method finds the line that minimizing the distance all the data points are away from the 

best-fit line.  This may sound complicated but it is really not if you know a little algebra 

and one concept from calculus.  Recall, that in math to find distance we use absolute 

value, which is equivalent to the square root of the square*.  (The squaring and 

subsequent square rooting of a quantity is a common mathematical trick to substitute 

taking an absolute value.)  Let us start with an experiment, where you measure 

variables x and y over N trials.  The expected result is  

y = mx + b 

but remember that we take N measurements.  So we get 

     y1 = mx1 + b 

     y2 = mx2 + b 

     …. 

     yN = mxN + b. 

 

These equations are not in general consistent; if we take different pairs of 

equations, and solve them for m and b, we obtain different values for m and b.  The 

reason for the various values of m and b, of course, is that there are experimental errors 

in the yi.  Since the two sides of the equation, yi = mxi + b, are not exactly equal, but 

differ by an amount let’s call d.  To calculate d, we use 

    di = mxi + b – yi,  

where di is the deviation corresponding to the ith equation and the pair of observations 

(xi, yi).  Since the values for di are the results of the experimental errors, we can assume 

                                                             
* The terms for absolute value and square root of a square are equivalent. That is 2xx = . 
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that they are distributed according to the Gaussian (or normal) distribution.  This allows 

us to use the method of maximum likelihood to find the most probable values of m and 

b.   

 This method finds the most probable values of m and b by minimizing the sum of 

the squares of the deviations.  That is, we minimize the quantity, d2, which has the form 

( )∑ −+=
i

iii ybmxd 22 . 

The principle of least squares is finding the values of m and b that minimize d2.  To 

minimize the two variables, we take the partial derivative (due to the fact that m and b 

are in the equation) of the function with respect to each of the variables (m and b) in 

turn and set each derivative equal to zero.  Rearranging the equations, we get 1 

∑ ∑ += bNxmy ii  and  ∑∑∑ += iiii xbxmyx 2 ,  

where N is the number of points that are being used in the fitting process.  Further 

rearrangement, gives the following results for m and b: 
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These values for m and b, are the slope and y-intercept, respectively, for the best-fit line 

for the data.  This is the calculation that a computer or calculator makes to output the 

equation of the best-fit line. 

 

Propagation of Errors 

 Often in laboratory experiments, the results will not be measured directly.  

Rather, the results will be calculated from several measured physical quantities.  Each 

of these measured quantities consists of a mean (average) value and an error.  What is 

the resulting error in the final result of such an experiment?  It is difficult to say how the 

error of the measured quantities will translate (or propagate) to the error of the final 

result.   

 The difficulty arises because we do not which sign, plus or minus, really exists for 

the error.  Recall that when reporting error, we show both signs, ±, to indicate that we 

                                                             
1 The summations, Σ, are still over the index i but it has been dropped for convenience. 
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do not truly know where the true values lie.  As an example, assume that we measure 

two quantities, A ± ∆A and B±∆B.  (∆A and ∆B represent the error on A and B, 

respectively.)  Then, we combine A and B into Z by Z = A + B.  The extreme values of 

the error are easy to predict, they are given by  

( ) ( ) ( ) ( )BABABBAA ∆+∆++=∆++∆+  or ( ) ( ) ( ) ( )BABABBAA ∆+∆−+=∆−+∆− .  

The problem is that most likely there is a mixture, some error from A cancels some of 

the error or vice-versa.  Then the situation becomes more complicated.  However, this 

problem has arisen before, the distance between two points on the Cartesian plane.  

There we treat the distances independently (actually, perpendicular), but combine them 

by the Pythagorean theorem.  Simple enough solution, but what if the result, Z, depends 

on both A and B (Z is a function of A and B).  Then the problem uses the same method 

but involves partial derivatives.  (Note: The author considers this too complex of a 

concept to explain here and refers any interested readers to their instruction or 

multivariable calculus textbooks.)  Due to the complexity of the work with partial 

derivatives, the results of the error for various operations are given in the table below. 

 

Operation Relation between ∆Z, ∆A, and ∆B 

Z = A + B ( ) ( ) ( )222 BAZ ∆+∆=∆  

Z = A – B ( ) ( ) ( )222 BAZ ∆+∆=∆  

Z = AB 222
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∆
 

Z = ln (A) 

A

A
Z

∆
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Z = eA 

A
Z
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∆
 

                                                             
* n is a constant (any real number) 
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Any further discussion of data analysis and error analysis techniques should be referred 

to Taylor, John R. An Introduction to Error Analysis: The Study of Uncertainties in 

Physical Measurements. University Science Books, 1982. 
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Appendix D - Radiation Passing Through Matter 
 Our three forms of radiation must interact with matter while passing through it or 

we would never be able to detect them.  However, how they interact with matter is 

completely different.  Therefore, I will break this appendix up into three sections to study 

alpha particles, beta particles, and gamma rays individually. 

 

Alpha Particles 

 Alpha particles are helium nuclei, two protons and two neutrons, so it is 

considered a heavy particle (compared to other particles in the universe).  As an alpha 

particle passes through matter, it passes close to many atoms.  The positive charge 

from the alpha particle attracts an electron from the valence shell of an atom it passes.  

Sometimes the attraction is strong enough to free the electron from the atom, this 

process is known as ionization.  During this process, the alpha particle ends up giving 

up some energy to the freed electron.  This is the only true interaction that the alpha has 

besides depositing its energy in some atoms through inelastic collisions.  Either way, 

the alpha particle loses some energy each time it interacts, which is denoted by 

physicists as dE/dx.  To calculate dE/dx, one uses the Bethe-Bloch formula which is  
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 where 2 0 15352 2 2πN r m c MeV cm ga e e = . /  and  

re: classical electron radius = 2.817 x 10-13 cm  me: electron mass = 9.11 x 10-31 kg 

Na: Avogrado’s number = 6.022 x 1023 / mol  I: mean ionization energy  

Z: atomic number of absorbing material   A: atomic mass of absorbing material   

ρ: density of absorbing material    z: charge of incident particle in units of e 

β = v/c of the incident particle    γ = 
1

1 2− β
 

δ: density correction     C: shell correction 

Wmax: maximum energy transfer in a single collision ≈ 2 2m ce βγb g . 
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Note that the equation for dE/dx is negative to indicate that it is an energy loss.  There 

are two correction terms, one for density effects and one for shell effects.  While there 

are many other possible corrections that could be made, they are negligible (≈ 1%).   

The density effect arises due to the fact that atoms in the matter are polarized by 

the electric field of the alpha particle passing through it.  Thus, the electrons on the far 

side of the atom will be shielded from interactions with the particle.  However, the 

denser the material, the closer the atoms are together and more shielding that occurs.  

Since this term takes away possible interactions, is subtracted from the original formula. 

 The shell effect gives a small correction to the Bethe-Bloch formula, but still must 

be taken into account.  This effect only occurs when the velocity of the incident particle 

is equal to or less than the orbital speed of the electrons.  This situation invalidates the 

assumption that the electrons are stationary with respect to the incident particle.   

 While an alpha particle will lose energy in a collision, it is not much to make it 

stray from its path.  Therefore, an alpha particle passing through matter traverses it in a 

relatively straight path while giving up energy in mainly ionization interactions. 

 

Beta Particles 

 Beta particles are electrons that are emitted by the nucleus.  They also undergo 

the ionization energy loss as predicted by the Bethe-Bloch formula (Equation 1).  

However, electrons are much less massive than alpha particles, m mα β= 7342 , so there 

is additional interaction due to the fact that the beta particle is greatly scattered through 

matter.  A beta particle passing close to a nucleus can have an electromagnetic 

interaction that will slow the beta down and cause it to change directions, in essence it 

will be braking.  This “braking radiation” is described by its German name, 

bremmstrahlung.  Whenever the beta particle undergoes bremmstrahlung, it loses 

energy but when an electron changes energy, it must absorb or emit electrons.  Thus, 

bremmstrahlung is the production of x-ray photons due to the interactions of electrons 

(beta particles) with nuclei in matter. 

 Again, an alpha particle will pass almost straight through matter.  The opposite is 

true for a beta particle.  It undergoes multiple scatterings that cause it path to be very 

much of a “zig-zag” pattern with no way to predict its path.   
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Gamma Rays 

 Gamma rays are photons that have an energy, frequency, and wavelength 

sufficient enough to be classified as a gamma ray in the electromagnetic spectrum.  

Photons interact three different ways in matter: (1) Photoelectric effect, (2) Compton 

scattering, and (3) Pair production. 

 The photoelectric effect is when a photon is absorbed by an electron with the 

subsequent ejection of the electron from the atom.  The maximum energy of the ejected 

electron is given by  

KE Emax = −γ Φ            (2) 

where Eγ is the energy of the incident photon and Φ is the work function (energy 

necessary to free the electron). 

 Compton scattering is the scattering of photons on electrons.  Originally, this was 

only for free electrons but if the photon energy is sufficient to overcome the binding 

energy, then we can consider the electron as free.  In this collision, the photon is 

incident on the electron with an energy hν, where h is Planck’s constant and n is the 

frequency of the photon.  The photon undergoes an inelastic collision with the electron, 

so the photon gives some of its energy to the electron.  The photon leaves with a new 

energy hν’ and the electron leaves with a certain amount of kinetic energy that is ∆E = 

hν-hν’.  We can calculate hν’ by determining the scattering angle of the photon, θ.  Then 

we can use the equation: 

h h
′ =

+ −
ν ν

γ θ1 1 cosb g           (3) 

 The process of pair production refers to the transformation of a photon into an 

electron-positron pair.  In order to conserve momentum, this process can only occur 

when the photon is close to the nucleus.  Theoretically, the photon needs only the 

energy that equates to the mass of an electron-positron pair.  This energy is 1.022 MeV.  

However, this process very, very rarely occurs below 1.5 MeV of photon energy, 

because nature does not like creating the electron and positron and then having them 

just sit there.  Therefore, pair production only occurs when there is not only the mass 
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(energy) available, but also some extra energy for kinetic energy for the electron and 

positron.        

 The photoelectric effect dominates for photon energies from 4 eV up to 0.5 MeV.  

Then Compton scattering dominates up to 2 MeV.  Finally, pair production dominates 

above 10 MeV, but only if a nucleus is present to absorb the momentum.  (Between 2 

MeV and 10 MeV there is no true dominating absorption mechanism for photons.) 

 

 For further reading on this topic, please refer to the Suggested References 

section. 
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Appendix E – Suggested References 
 

There is a large amount of information in books, journal articles, and on the internet 

relating to the topics in this lab manual (Radiation, particle interaction with matter, and 

particle detection).  Since many high school teachers do not have access to journals, I 

have only listed books and website references.  

Two of the best books on the topics of particle detectors that cover Geiger counters 

are 

• Knoll, G. Radiation Detection and Measurement, John Wiley & Sons, 1989. 

• Tsoulfanidis, N. Measurement and Detection of Radiation, McGraw-Hill, 1995. 

 

As for websites, there is a very large amount of websites that would consume page 

after page of this manual.  Instead, this is a small sample of websites, which represent 

the ones that the author deemed most helpful while writing this manual.  They are not 

listed in any particular order of importance, just alphabetically.  Also, these sites were 

verified in July of 2002, and any further accuracy of the information cannot be 

guaranteed.  In addition, if further resources are desired, do a search on a website such 

as Google (http://www.google.com).    

 
• American Nuclear Society – http://www.ans.org 

This is the professional organization for nuclear engineers, nuclear scientists, 

and other nuclear related professionals.  They sponsor very good programs for 

teachers in different areas of the country.  There is large public information 

section covering many different levels of education. 

 
• EPA – Radiation Protection Program – http://www.epa.gov/radiation 

 
This is the EPA’s webpage for how to protect the environment from radiation’s 

harm.  How they clean it up after it happens.  The EPA also tries to educate 

people that not all radiation is harmful. 
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• Health Physics Society – http://www.hps.org 
 

This is the professional organization for health physicists.  It has more public 
information available, as well as an “Ask the Expert” area.  Some of its regional 
chapters are excellent resources as well. 

 
• Nuclear Enginnering 104A: Radiation Detection and Nuclear 

Instrumentation Laboratory (Fall 2001) – 
http://www.nuc.berkeley.edu/dept/Courses/NE_104A 

 
This link leads you to a list of files that comprise the course information.  There is 
no main page that accesses all of the files.  This course contains many materials 
on the basics of radiation and its detection. 
 

• RadEFX Radiation Health Effects Information Resource - 
http://radefx.bcm.tmc.edu/chernobyl 

 
This is a very neat webpage where experts answer questions from basic 
radiation facts to questions mainly focusing on the effects worldwide of 
Chernobyl.   

   

• Radiological Information from the Collider-Acceleration Group at 
Brookhaven National Laboratory – 
http://www.agsrhichome.bnl.gov/AGS/Accel/SND/radiological_information.htm 

 
This site covers radiation safety information from the most basic form to the very 

advanced concepts that are involved at the AGS and RHIC particle colliders at 

BNL.  The link on elements is very good. 

 
• Texas Department of Health – Bureau of Radiation Control – 

http://www.tdh.state.tx.us/ech/rad/pages/brc.htm 
 

This is the website of the State’s controlling entity in Texas.  (It is suggested that 

you find your state’s radiation department for information relevant to your state.)  

There may or may not be education information available, it depends on the 

state. 
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• The Radiation and Health Physics Page – 
http://www.umich.edu/~radinfo/nojava.html 

 
This is perhaps one of the best, or at least most referenced, webpage dealing 

with radiation on the internet.  It is a comprehensive website that does supply 

educational resources. 

 
• US Nuclear Regulatory Commision – http://www.nrc.gov 

 
Find out what the controlling entity in the US for radiation does.  There are also 

public information materials available. 

 

• University of Waterloo Radiation Safety Training – 
http://www.rstp.uwaterloo.ca 

 
Good online training manual with a lot of basic information using animated gifs.  

Many of the particle interactions with matter are animated. 

 

• Uranium Information Centre (Melbourne, Australia) – 
http://www.uic.com.au/ral.htm 

 
This is an awesome introduction to radiation all around us in everyday life.  There 

are many good cartoon figures that explain the concepts being discussed. 

 

• Wocester Polytechnic Institute’s Radiation Safety Training and Reference 
Manual – http://www.wpi.edu/Admin/Safety/RSO/Training/trm.html 

 
This radiation safety manual is online and covers the basics for many different 

professions that interact with radiation. 
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Appendix F – NRC Regulations  

10 CFR 30.18, 30.71 Schedule B, and 32.19 

 

§30.18 Exempt quantities. 
(a) Except as provided in paragraphs (c) and (d) of this section, any person is exempt 
from the requirements for a license set forth in section 81 of the Act and from the 
regulations in parts 30 through 34, 36 and 39 of this chapter to the extent that such person 
receives, possesses, uses, transfers, owns, or acquires byproduct material in individual 
quantities each of which does not exceed the applicable quantity set forth in §30.71, 
Schedule B. 
(b) Any person who possesses byproduct material received or acquired prior to 
September 25, 1971 under the general license then provided in §31.4 of this chapter is 
exempt from the requirements for a license set forth in section 81 of the Act and from the 
regulations in parts 30 through 34 of this chapter to the extent that such person possesses, 
uses, transfers, or owns such byproduct material. 
(c) This section does not authorize for purposes of commercial distribution the 
production, packaging, repackaging, or transfer of byproduct material or the 
incorporation of byproduct material into products intended for commercial distribution. 
(d) No person may, for purposes of commercial distribution, transfer byproduct material 
in the individual quantities set forth in §30.71 Schedule B, knowing or having reason to 
believe that such quantities of byproduct material will be transferred to persons exempt 
under this section or equivalent regulations of an Agreement State, except in accordance 
with a license issued under §32.18 of this chapter, which license states that the byproduct 
material may be transferred by the licensee to persons exempt under this section or the 
equivalent regulations of an Agreement State. 
[35 FR 6427, Apr. 22, 1970, as amended at 36 FR 16898, Aug. 26, 1971; 43 FR 6921, 
Feb. 17, 1978; 52 FR 8241, Mar. 17, 1987; 58 FR 7736, Feb. 9, 1993] 
 

 

§30.71 Schedule B.  
Byproduct material Microcuries 

Antimony 122 (Sb 122) 100 
Antimony 124 (Sb 124) 10 
Antimony 125 (Sb 125) 10 

Arsenic 73 (As 73) 100 
Arsenic 74 (As 74) 10 
Arsenic 76 (As 76) 10 
Arsenic 77 (as 77) 100 

Barium 131 (Ba 131) 10 
Barium 133 (Ba 133) 10 
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Barium 140 (Ba 140) 10 
Bismuth 210 (Bi 210) 1 
Bromine 82 (Br 82) 10 

Cadmium 109 (Cd 109) 10 
Cadmium 115m (Cd 115m) 10 

Cadmium 115 (Cd 115) 100 
Calcium 45 (Ca 45) 10 
Calcium 47 (Ca 47) 10 

Carbon 14 © 14) 100 
Cerium 141 (Ce 141) 100 
Cerium 143 (Ce 143) 100 
Cerium 144 (Ce 144) 1 
Cesium 131 (Cs 131) 1,000 

Cesium 134m (Cs 134m) 100 
Cesium 134 (Cs 134) 1 
Cesium 135 (Cs 135) 10 
Cesium 136 (Cs 136) 10 
Cesium 137 (Cs 137) 10 
Chlorine 36 (Cl 36) 10 
Chlorine 38 (Cl 38) 10 

Chromium 51 (Cr 51) 1,000 
Cobalt 58m (Co 58m) 10 

Cobalt 58 (Co 58) 10 
Cobalt 60 (Co 60) 1 
Cobalt 64 (Cu 64) 100 

Dysprosium 165 (Dy 165) 10 
Dysprosium 166 (Dy 166) 100 

Erbium 169 (Er 169) 100 
Erbium 171 (Er 171) 100 

Europium 152 9.2 h (Eu 152 
9.2 h) 

100 

Europium 152 13 yr (Eu 152 
13 yr) 

1 

Europium 154 (Eu 154) 1 
Europium 155 (Eu 155) 10 

Fluorine 18 (F 18) 1,000 
Gadolinium 153 (Gd 153) 10 
Gadolinium 159 (Gd 159) 100 



134 

 

Gallium 72 (Ga 72) 10 
Germanium 71 (Ga 71) 100 

Gold 198 (Au 198) 100 
Gold 199 (Au 199) 100 

Hafnium 181 (Hf 181) 10 
Holmium 166 (Ho 166) 100 

Hydrogen 3 (H3) 1,000 
Indium 113m (In 113m) 100 
Indium 114m (In 114m) 10 
Indium 115m (In 115m) 100 

Indium 115 (In 115) 10 
Iodine 125 (I 125) 1 
Iodine 126 (I 126) 1 
Iodine 129 (I 129) 0,1 
Iodine 131 (I 131) 1 
Iodine 132 (I 132) 10 
Iodine 133 (I 133) 1 
Iodine 134 (I 134) 10 
Iodine 135 (I 135) 10 

Iridium 192 (Ir 192) 10 
Iridium 194 (Ir 194) 100 

Iron 55 (Fe 55) 100 
Iron 59 (Fe 59) 10 

Krypton 85 (Kr 85) 100 
Krypton 87 (Kr 87) 10 

Lanthanum 140 (La 140) 10 
Lutetium 177 (Lu 177) 100 
Manganese 52 (Mn 52) 10 
Manganese 54 (Mn 54) 10 
Manganese 56 (Mn 56) 10 

Mercury 197m (Hg 197m) 100 
Mercury 197 (Hg 197) 100 
Mercury 203 (Hg 203) 10 
Molbdenum 99 (Mo 99) 100 

Neodymium 147 (Nd 147) 100 
Neodymium 149 (Nd 149) 100 

Nickel 59 (Ni 59) 100 
Nickel 63 (Ni 63) 10 
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Nickel 65 (Ni 65) 100 
Niobium 93m (Nb 93m) 10 

Niobium 95 (Nb 95)  ̀ 10 
Niobium 97 (Nb 97) 10 

Osmium 185 (Os 185) 10 
Osmium 191m (Os 191) 100 
Osmium 191 (Os 191) 100 
Osmium 193 (Os 193) 100 

Palladium 103 (Pd 103) 100 
Palladium 109 (Pd 109) 100 
Phosphorus 32 (P 32) 10 
Platinum 191 (Pt 191) 100 

Platinum 193m (Pt 193m) 100 
Platinum 193 (Pt 193) 100 

Platinum 197m (Pt 197m) 100 
Platinum 197 (Pt 197) 100 

Polonium 210 (Po 210) 0.1 
Potassium 42 (K 42) 10 

Praseodymium 142 (Pr 142) 100 
Praseodymium 143 (Pr 143) 100 
Promethium 147 (Pm 147) 10 
Promethium 149 (Pm 149) 10 

Rhenium 186 (Re 186) 100 
Rhenium 188 (Re 188) 100 

Rhodium 103m (Rh 103m) 100 
Rhodium 105 (Rh 105) 100 

Rubidium 86 (R86) 10 
Rubidium 87 (Rb87) 10 
Ruthenium 97 (Ru 97) 100 

Ruthenium 103 (Ru 103) 10 
Ruthenium 105 (Ru 105) 10 
Ruthenium 106 (Ru 106) 1 
Samarium 151 (Sm 151) 10 
Samarium 153 (Sm 153) 100 

Scandium 46 (Sc 46) 10 
Scandium 47 (Sc 47) 100 
Scandium 48 (Sc 48) 10 
Selenium 75 (Se 75) 10 
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Silicon 31 (Si 31) 100 
Silver 105 (Ag 105) 10 

Silver 110m (Ag 110m) 1 
Silver 111 (Ag 111) 100 
Soldium 24 (Na 24) 10 
Strontium 85 (Sr 85) 10 
Strontium 89 (Sr 89) 1 
Strontium 90 (Sr 90) 0.1 
Strontium 91 (Sr 91) 10 
Strontium 92 (Sr 92) 10 

Sulphur 35 (S 35) 100 
Tantalum 182 (Ta 182) 10 
Technetium 96 (Tc 96) 10 

Technetium 97m (Tc 97m) 100 
Technetium 97 (Tc 97) 100 

Technetium 99m (Tc 99m) 100 
Technetium 99 (Tc 99) 10 

Tellurium 125 m (Te 125 m) 10 
Tellurium 127m (Te 127m) 10 

Tellurium 127 (Te 127) 100 
Tellurium 129m (Te 129m) 10 

Tellurium 129 (Te 129) 100 
Tellurium 131m (Te 131m) 10 

Tellurium 132 (Te 132) 10 
Terbium 160 (Tb 160) 10 
Thallium 200 (Tl 200) 100 
Thallium 201 (Tl 201) 100 
Thallium 202 (Tl 202) 100 
Thallium 204 (Tl 204) 10 
Thulium 170 (Tm 170) 10 
Thulium 171 (Tm 171) 10 

Tin 113 (Sn 113) 10 
Tin 125 (Sn 125) 10 

Tungsten 181 (W 181) 10 
Tungsten 185 (W 185) 10 
Tungsten 187 (W 187) 100 
Vanadium 48 (V 48) 10 

Xenon 131m (Xe 131m) 1,000 
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Xenon 133 (Xe 133) 100 
Xenon 135 (Xe 135) 100 

Ytterbium 175 (Yb 175) 100 
Yttrium 90 (Y 90) 10 
Yttrium 91 (Y91) 10 
Yttrium 92 (Y92) 100 
Yttrium 93 (Y93) 100 
Zinc 65 (Zn 65) 10 

Zinc 69m (Zn 69m) 100 
Zinc 69 (Zn 69) 1,000 

Zirconium 93 (Zr 93) 10 
Zirconium 95 (Zr 95) 10 
Zirconium 97 (Zr 97) 10 

Any byproduct material not 
listed above other than alpha 

emitting byrproduct 
materials 

0.1 

[35 FR 6427, Apr. 22, 1970, as amended at 36 FR 16898, Aug. 26, 1971; 59 FR 5519, Feb. 7, 
1994] 
 
 
 
§32.19 Same: Conditions of licenses. 
Each license issued under §32.18 is subject to the following conditions: 
(a) No more than 10 exempt quantities set forth in §30.71, Schedule B of this chapter 
shall be sold or transferred in any single transaction. For purposes of this requirement, an 
individual exempt quantity may be composed of fractional parts of one or more of the 
exempt quantities in §30.71, Schedule B of this chapter, provided that the sum of such 
fractions shall not exceed unity. 
(b) Each quantity of byproduct material set forth in §30.71, Schedule B of this chapter 
shall be separately and individually packaged. No more than 10 such packaged exempt 
quantities shall be contained in any outer package for transfer to persons exempt pursuant 
to §30.18 of this chapter. The outer package shall be such that the dose rate at the 
external surface of the package does not exceed 0.5 millirem per hour. 
(c) The immediate container of each quantity or separately packaged fractional quantity 
of byproduct material shall bear a durable, legible label which (1) identifies the 
radioisotope and the quantity of radioactivity, and (2) bears the words "Radioactive 
Material." 
(d) In addition to the labeling information required by paragraph (c) of this section, the 
label affixed to the immediate container, or an accompanying brochure, shall also (1) 
state that the contents are exempt from NRC or Agreement State licensing requirements; 
(2) bear the words "Radioactive Material -- Not for Human Use -- Introduction Into 
Foods, Beverages, Cosmetics, Drugs, or Medicinals, or Into Products Manufactured for 
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Commercial Distribution is Prohibited -- Exempt Quantities Should Not be Combined"; 
and (3) set forth appropriate additional radiation safety precautions and instructions 
relating to the handling, use, storage, and disposal of the radioactive material. 
[35 FR 6428, Apr. 22, 1970] 

 


